@ HP EliteBook 2170p Notebook PC

Maintenance and Service Guide



© Copyright 2012 Hewlett-Packard
Development Company, L.P.

Bluetooth is a trademark owned by its
proprietor and used by Hewlett-Packard
Company under license. Intel and Core are
trademarks or registered trademarks of Intel
Corporation in the United States and other
countries. Microsoft and Windows are U.S.
registered frademarks of Microsoft
Corporation. SD logo is a trademark of

its proprietor.

The information contained herein is subject
to change without notice. The only
warranties for HP products and services are
set forth in the express warranty statements
accompanying such products and services.
Nothing herein should be construed as
constituting an additional warranty. HP shall
not be liable for technical or editorial errors
or omissions contained herein.

Second Edition: October 2012
First Edition: June 2012
Document Part Number: 677134-002



Safety warning notice

/\ WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the
skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description

Category

Description

Product Name

HP EliteBook 2170p Notebook PC

Processors

Intel® Quad Core® i7-3687U 2.10-GHz processor (SC turbo up to 3.30-GHz, 4.0-
MB L3 cache, 17 W)

Intel Dual Core i7-3667U 1.80-GHz processor (SC turbo up to 2.90-GHz; 4.0-
MB L3 cache, 17 W)

Intel Dual Core i5-3437U 1.90-GHz processor (SC turbo up to 2.90-GHz, 3.0-
MB L3 cache, 17 W)

Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to 2.70-GHz; 3.0-
MB L3 cache, 17 W)

Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to 2.60-GHz; 3.0-
MB L3 cache, 17 W)

Intel Dual Core i3-3217U 1.80-GHz processor (3.0-MB L3 cache, 17 W)

Chipset

Mobile Intel QM77 chipset

Graphics

Intel HD Graphics 4000 integrated universal memory architecture (UMA) graphics

Panel

11.6-in light-emitting diode (LED), high-definition (HD), AntiGlare (AG), SVA (1368x768)

display with and without webcam and microphone

All display assemblies include two wireless local area network (WLAN) antenna cables and
two wireless wide area network (WWAN) antenna cables

Supports low voltage differential signalling (LVDS)

Supports optional privacy filter
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Category

Description

Memory

Two customer-accessible/upgradable memory module slots
DDR3-12800 (1600-MHz) dual channel support

Supports 16384-MB of system RAM in the following configurations:
o 16384-MB (8192-MBx2, dual channel)

e  12288-MB (8192-MBx1+4096-MBx 1, dual channel)

e 8192-MB (8192-MBx1 or 4096x2, dual channel)

o 4096-MB (4096-MBx1 or 2048-MBx2, dual channel)

e 2048-MB (2048x1)

Hard drive

Supports 6.35-cm (2.5-in) hard drives in 9.5-mm (.37-in) and 7.0-mm (.28-in) thicknesses
(all hard drives use the same bracket)

Customer-accessible

Serial ATA

Supports the following hard drives:

e  750-GB, 7200-rpm, 9.5-mm

e 500-GB, 7200-rpm, 7.0-mm self-encrypting drive (SED)
e  500-GB, 7200-rpm, 7.0-mm

e  320-GB, 7200-rpm, 7.0-mm

Solid-state drive

Solid-state drive (SSD) mounts in the same bracket as the hard drive
Customer-accessible
Serial ATA type Il and Il

Supports the following SSDs:

e 256GBSEDII
e 240GB Il
e 180GBIll
e 160GBII
e 128GBIl

Audio and video

Two stereo speakers

HD audio with SRS Premium Sound PRO

Integrated 720p HD webcam (supports no camera option)

Integrated dual-array microphone on computer models equipped with a webcam

Integrated mono microphone on computer models not equipped with a webcam

Chapter 1
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Category

Description

Ethernet Intel 82579LM 10/100/1000 Ethernet network interface card (NIC)
NIC Power Down technology
S3/54/S5 wake on LAN
Ethernet cable not included
Wireless Integrated wireless local area network (WLAN) options by way of wireless module

Two WLAN antennas built into display assembly
Support for the following WLAN formats:
e Atheros AR9462 802.11a/b/g/n 2x2 Bluetooth 4.0 Combo Adapter

®  Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 20702 Bluetooth 4.0
Combo Adapter

e Intel Centrino Advanced-N 6235 WLAN module
e Intel Centrino Advanced-N 6205 WLAN module

Support for no WLAN option

Integrated wireless wide area network (WWAN) options by way of wireless module
Two world-wide/5-band WWAN antennas built into display assembly

Secured by subscriber identity module (SIM, user-accessible inside battery bay)
Support for the following WWAN formats:

e HP hs2350 HSPA+ Mobile Broadband Module

e HP [t2523 LTE/HSPA+ Mobile Broadband Module

HP 1t2522 LTE/EV-DO Mobile Broadband Module

e  HP un2430 EV-DO/HSPA Mini Card

e  HP un2430 EV-DO/HSPA Mobile Broadband Module
Support for no WWAN option

Support for WWAN after market option

External media cards

Integrated Smart Card reader

Secure Digital (SD) Media reader slot with push-push technology, supporting the following
digital card formats:

e  MultiMediaCard (MMC)

e  MMC+

e  Secure Digital (SD) Memory Card
e SDHC

e SDXC
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Category

Description

Ports e Audio-in (mono microphone)/audio-out (stereo headphone) combo jack

®  Battery connector

e DisplayPort 1.1a

e Docking connector

e HP Smart AC adapter

e RJ-45 (Ethernet)

e USB 3.0 ports (2: 1 USB 3.0 charging port, 1 USB 3.0 port)

e VGA (Dsub 15-pin) supporting: 1920x1200 external resolution @ 75 Hz, hot plug and

unplug and autodetection for correct output to wide-aspect vs. standard aspect video

Keyboard/pointing Chicletstyle keyboard with numeric keypad (upper-left justified), dual-point, spill-resistant with
devices drain, durakeys, backlit (optional)

Gesture support: MultiTouch gestures enabled, two-finger scrolling, and pinch-zoom
as default

Taps enabled by default
Support for TouchPad with image sensor

Support for 2-way scroll

Power requirements

Supports the following AC adapters:
e 65W HP Smart AC adapter (PFC, RC/V, EM, 3-wire)
e 65W HP Smart AC adapter (non-PFC, 3-wire)

e 65-W HP travel AC adapter (non-PFC, 3-wire)

Support for 6-cell, 48-Wh, 2.20-Ah and 4-cell, 30-Wh, 2.00-Ah Li ion batteries

Security

Support for security cable lock
Support for fingerprint reader and no fingerprint reader option

Support for Trusted Platform Module (TPM) 1.2 (Infineon, soldered down) and TPM Enhanced
Drive Lock (not supported in Asia and the People's Republic of China)

Integrated Smart Card reader (active)
Full volume encryption

Preboot authentication (password, Smart Card)

Chapter 1
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Category

Description

Operating system

Preinstalled:

Windows® 8 ML 64 with Microsoft Basics (Japan only)

Windows 8 Professional 64 with Microsoft Basics (Japan only)

Windows 8 Professional 64 DPK with Windows 7 Professional 64 and 32 (Japan only)
Windows 7 Home Premium 64 and 32 with Microsoft Basics

Windows 7 Professional 64 and 32 with Microsoft Basics

Windows 7 Service Pack 1

FreeDOS

SUSE Linux (SLED; People's Republic it China only)
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Category

Description

Operating system
(continued)

Preinstalled with Microsoft Office:

e Windows 8 CH 64-bit with Office 2010 Transition OPK (People's Republic of
China only)

®*  Windows 8 EM 64-bit with Office 2010 Transition OPK (not available in Japan)

e Windows 8 ML 64-bit with Office 2010 Business and Home (Japan only; requires
configuration with Office Personal Japan 2010 app AV)

®  Windows 8 ML 64-bit with Office 2010 Personal (Japan only; requires configuration
with Office Personal Japan 2010 app AV)

e Windows 8 ML 64-bit with Office 2010 Professional (Japan only; requires configuration
with Office Personal Japan 2010 app AV)

e Windows 8 ML 64-bit with Office 2010 Transition OPK (not available in Japan)

®  Windows 8 Professional 64-bit DPK with Windows 7 Professional 64- and 32-bit with
Office 2010 Business and Home (Japan only; requires configuration with Office
Personal Japan 2010 app AV)

e  Windows 8 Professional 64-bit DPK with Windows 7 Professional 64- and 32-bit with
Office 2010 Personal (Japan only; requires configuration with Office Personal Japan
2010 app AV)

®  Windows 8 Professional 64-bit DPK with Windows 7 Professional 64- and 32-bit with
Office 2010 Professional (Japan only; requires configuration with Office Personal Japan
2010 app AV)

e  Windows 8 Professional 64-bit DPK with Windows 7 Professional 64- and 32-bit with
Office 2010 Starter (not available in Asia-Pacific countries and regions, Japan, or the
People's Republic of China)

e Windows 8 Professional 64-bit with Office 2010 Business and Home (Japan only;
requires configuration with Office Personal Japan 2010 app AV)

®  Windows 8 Professional 64-bit with Office 2010 Personal (Japan only; requires
configuration with Office Personal Japan 2010 app AV)

®  Windows 8 Professional 64-bit with Office 2010 Professional (Japan only; requires
configuration with Office Personal Japan 2010 app AV)

®  Windows 8 Professional 64-bit with Office 2010 Transition OPK (not available
in Japan)

®  Windows 7 Home Basic 32-bit with Office Starter (emerging markets only)

e Windows 7 Home Premium é4- and 32-bit with Office Starter (not available in Japan)

®  Windows 7 Home Premium 64-bit with Office 2010 Personal (only in Japan)

e Windows 7 Home Premium 64-bit with Office 2010 Home & Business (only in Japan)

®  Windows 7 Home Premium 6é4-bit with Office 2010 Personal (only in Japan)

e Windows 7 Home Premium 64-bit with Office 2010 Professional (only in Japan)

(Continued)

Chapter 1
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Category

Description

Operating system
(continued)

Preinstalled with Microsoft Office: (Continued)

Windows 7 Professional 64- and 32-bit with Office 2010 Starter (not available
in Japan)

Windows 7 Professional 64- and 32-bit with Office 2010 Business & Home (only
in Japan)

Windows 7 Professional 64- and 32-bit with Office 2010 Personal (only in Japan)

Windows 7 Professional 64- and 32-bit with Office 2010 Professional (only in Japan)

Restore media—DR-DVD:

Windows 8 (available with any Windows 8 operating system and required with
Windows 8 Professional 64-bit DPK with Windows 7 image)

Windows 7 (available with any Windows 7 HP, Windows 7 Professional loc, Windows
7 HB, or Windows 8 Professional 64-bit DPK with Windows 7 image)

Restore media—0OS-DVD:

e Windows 8 Professional 64-bit (required with Windows 8 Professional 64-bit DPK with
Windows image)

®  Windows 7 Home Basic 32-bit (available with any Windows 7 Home Basic location
except Asia-Pacific countries and regions and the People's Republic of China)

®  Windows 7 Home Premium 64- and 32-bit (available with any Windows 7 Premium
location except Asia-Pacific countries and regions and the People's Republic of China)

®  Windows 7 Professional 64- and 32-bit (available with any Windows 7 Professional or
Windows 8 Professional 64bit DPK with Windows image location except Asia-Pacific
countries and regions and the People's Republic of China)

Certified:

®  Microsoft WHQL

®  SuSE Linux Enterprise (SLED) 64-bit Service Pack 2




Category Description

Operating system Web-only support:
(continued)
e Windows 8 32-bit
e Windows XP Pro 32-bit
®  Windows 7 Enterprise 64- and 32-bit

o  Windows 7 Ultimate 64- and 32-bit

Serviceability End user replaceable parts:
e AC adapter

e  Battery

Hard drive

Keyboard

e Memory module

Solid-state drive

WILAN module

WWAN module

Chapter 1 Product description



2 External component identification

Item

Component

Description

m

WILAN antennas (2)*

Send and receive wireless signals to communicate
with WLANSs (select models only).

(2)

WWAN antennas (2)*

Send and receive wireless signals to communicate
with WWANS (select models only).

(3)

Internal microphones (2)

Record sound.

4)

Webcam light (select models only)

On: The webcam is in use.

Display



Item Component Description

(5) Webcam (select models only) Records video and captures still photographs.
To use the webcam, do the following:

®  In Windows 8-Access Help and Support. From the
Start screen, type h, and then select Help and
Support.

®  In Windows 7-Select Start > All Programs >
Communication and Chat > HP Webcam.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. To see wireless regulatory notices, do the following:

® In Windows 8-See the section of the Regulatory, Safety, and Environmental Notices that applies to your country or
region. To access the user guides, from the Start screen, select the HP Support Assistant app, select My computer,
and then select User guides.

® In Windows 7-See the section of the Regulatory, Safety, and Environmental Notices that applies to your country
or region.

Buttons and fingerprint reader (select models only)

@NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description
(1 TouchPad on/off button Turns the TouchPad on and off.
(2) Fingerprint reader (select models only) Allows a fingerprint logon instead of a password logon.

10 Chapter 2 External component identification



Keys

E"%NOTE: Your computer may look slightly different from the illustration in this section.

®OBOH® HBEW)

ltem Component Description

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Executes frequently used system functions when pressed
in combination with a function key, the num Ik key, the
esc key, or other keys.

(3) Windows logo key Displays the Windows Start menu.

(4) Function keys Execute frequently used system functions when pressed in
combination with the fn key.

(5) Embedded numeric keypad When the keypad is turned on, it can be used like an
external numeric keypad.

Each key on the keypad performs the function indicated
by the icon in the upper-right corner of the key.

(6) Windows applications key Displays a shortcut menu for items beneath the cursor.

(7) num lk key Turns the embedded numeric keypad on and off when

pressed in combination with the fn key.

Keys 11



Lights

@NOTE: Your computer may look slightly different from the illustration in this section.

12

Item Component Description

(1) Wireless light e  Off: An integrated wireless device, such as a
WILAN device, a WWAN device, and/or a
Bluetooth device, is on (select models only).

e Amber: All wireless devices are off

(select models only).

(2) Num lock light On: Num lock is on.

(3) Caps lock light On: Caps lock is on.

(4) TouchPad light e Amber: The TouchPad is off.

Off: The TouchPad is on.

Chapter 2 External component identification



TouchPad

r__f'%NOTE: Your computer may look slightly different from the illustration in this section.

Item

Component

Description

m

Pointing stick

Moves the pointer and selects or activates items on
the screen.

(2)

Left pointing stick button

Functions like the left button on an external mouse.

(3)

TouchPad on/off button

Turns the TouchPad on or off.

(4

TouchPad zone

Moves the pointer and selects or activates items on
the screen.

(5)

Left TouchPad button

Functions like the left button on an external mouse.

(6)

Right pointing stick button

Functions like the right button on an external mouse.

)

Right TouchPad button

Functions like the right button on an external mouse.

TouchPad

13
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Front

@NOTE: Your computer may look slightly different from the illustration in this section.

DOOS

7

5 & A

=

Item Component Description
W) Wireless light e White: An integrated wireless device, such as a
WILAN device and/or a WWAN device, is on.

e Amber: All wireless devices are off.

(2) Power light e On: The computer is on.
e Blinking: The computer is in the Sleep state.
e  Off: The computer is off or in Hibernation.

(3) AC adapter/Battery light ®  Amber: The computer is connected fo external

power and the battery is charged from O to
90 percent.

White: The computer is connected to external power
and the battery is charged from 90 to 99 percent.

Blinking amber: A battery that is the only available
power source has reached a low battery level.
When the battery reaches a critical battery level, the
battery light begins blinking rapidly.

Off: The battery is fully charged.

4

Hard drive light

Blinking white: The hard drive is being accessed.

Amber: HP 3D DriveGuard has temporarily parked
the hard drive.

(5)

Speakers (2)

Produce SRS Premium Sound or SRS Premium Sound PRO
(select models only).

NOTE: To use the SRS Premium Sound PRO software,
do the following:

Windows 8 — From the Start screen, type SRS, and
then select SRS Premium Sound.

Windows 7 - Select Start > All Programs >
SRS Premium Sound.

Chapter

2 External component identification



Left side

E’%NOTE: Your computer may look slightly different from the illustration in this section.

o b
®Q

6 &
e

ltem Component Description

(1) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deferrent, but it may not prevent the computer from being
mishandled or stolen.

(2) Power connector Connects an AC adapter.

(3) USB 3.0 port Connects optional USB 3.0 devices and provide
enhanced USB power performance.

(4) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(5) Smart Card reader (select models only) Supports optional smart cards.
(6) DisplayPort Connects an optional digital display device, such as a
high-performance monitor or projector.
(7) Audio-out (headphone) jack/Audio-in Produces sound when connected to optional powered
(microphone) jack stereo speakers, headphones, earbuds, a headset, or
television audio. Also connects an optional headset
microphone.

WARNING! To reduce the risk of personal injury,
adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety information,
see the Regulatory, Safety, and Environmental Notices.

NOTE: When a device is connected to the jack, the
computer speakers are disabled.

NOTE: Be sure that the device cable has a 4-conductor
connector that supports both audio-out (headphone) and
audio-in (microphone).

Left side 15



Right side

@NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Media Card reader Supports the following digital card formats:

MultiMediaCard (MMC)

MMC+

Secure Digital (SD) Memory Card
SDHC

SDXC

16 Chapter 2 External component identification



Item

Component

Description

(2)

Power switch

®  When the computer is off, slide the switch to turn on
the computer.

®  When the computer is on, slide the switch briefly to
initiate Sleep.

e When the computer is in the Suspend state, slide the
switch briefly to exit Sleep.

e When the computer is in Hibernation, slide the
switch briefly to exit Hibernation.

CAUTION: Sliding and holding the power switch will
result in the loss of unsaved information.

If the computer has stopped responding and

operating system shutdown procedures are ineffective,
press and hold the power button for at least 5 seconds to
turn off the computer.

To learn more about your power settings:

Windows 8 — See your power options. From the Start
screen, type power, select Settings, and then select
Power Options.

Windows 7:

e  Select Start > Control Panel > System and
Security > Power Options.

e For more information, see the HP Notebook
Reference Guide.

(3)

USB 3.0 charging port

Connects an optional USB 3.0 device and provides
enhanced USB power performance. The USB 3.0
charging port can also charge select models of cell
phones and MP3 players, even when the computer is off.

NOTE: A charging USB port (also referred to as a
powered USB port) allows you to charge connected USB
devices. Standard USB ports will not charge all USB
devices or will charge using a low current. Some USB
devices require power and require you to use a
powered port.

(4)

RJ-45 (network) jack

Connects a network cable.

(5)

External monitor port

Connects an external VGA monitor or projector.

Right side
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Bottom

@NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Vents (2) Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(2) Service cover Provides access to the hard drive bay, the WLAN module
slot, the WWAN module slot, and the memory
module slots.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact support through
Help and Support.

(3) Battery lock latch Releases the battery from the computer.

(4) SIM slot Supports a wireless subscriber identity module (SIM)
(select models only). The SIM slot is located inside the
battery bay.

(5) Battery bay Holds the battery.
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Item Component Description

(6) Docking connector Connects an optional docking device.

(7) Battery release latch Releases the battery.
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Service tag

When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag. It is necessary to remove the battery to obtain these numbers. See Battery
on page 56 for battery removal instructions.

O Serial: 0000000 [IIWIMUNTENWENEN

—Produd: XX00000X | IMNMMEMNInNNnIm
L _Warranty: 1y1y0y
| Model: X000000X

Item Description Function

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about the
product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.

Service tag 21
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Item Component Spare part number

(1) Display assembly: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see Display assembly subcomponents on page 31.

(2) Keyboard with backlight and pointing stick (includes keyboard cable, backlight cable, and pointing stick cable):
For use only on computer models equipped with the Windows 8 Standard and Professional operating system:
For use in Belgium 705614-A41
For use in Brazil 705614-201
For use in Bulgaria 705614261
For use in Canada 705614-DB1
For use in the Czech Republic and Slovakia 705614-FL1
For use in Denmark 705614-081
For use in France 705614-051
For use in Germany 705614-041
For use in Greece 705614-151
For use in Hungary 705614-211
For use in Iceland 705614-DD1
For use in India 705614-D61
For use in Israel 705614-BB1
For use in Italy 705614-061
For use in Japan 705614-291
For use in Latin America 705614-161
For use in the Netherlands 705614831
For use in Norway 705614-091
For use in Northwest Africa 705614-FP1
For use in Portugal 705614-131
For use in Romania 705614-271
For use in Russia 705614-251
For use in Saudi Arabia 705614-171
For use in Slovenia 705614-BA1
For use in South Korea 705614-AD1
For use in Spain 705614-071
For use in Sweden and Finland 705614871
For use in Switzerland 705614-BG1
For use in Taiwan 705614-AB1

Computer major components
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Item Component Spare part number

For use in Thailand 705614-281
For use in Turkey 705614-141
For use in the United Kingdom and Singapore 705614031
For use in the United States 705614-001

For use only on computer models equipped with the Windows 7 operating system:

For use in Belgium 693363-A41
For use in Brazil 693363-201
For use in Bulgaria 693363-261
For use in Canada 693363-DB1
For use in the Czech Republic and Slovakia 693363-FL1

For use in Denmark 693363-081
For use in France 693363-051
For use in Germany 693363-041
For use in Greece 693363-151
For use in Hungary 693363-211
For use in Iceland 693363-DD1
For use in India 693363-D61
For use in Israel 693363-BB1
For use in ltaly 693363-061
For use in Japan 693363-291
For use in Latin America 693363-161
For use in the Netherlands 693363-B31
For use in Norway 693363-091
For use in Northwest Africa 693363-FP1

For use in Portugal 693363-131
For use in Romania 693363-271
For use in Russia 693363-251
For use in Saudi Arabia 693363-171
For use in Slovenia 693363-BA1
For use in South Korea 693363-AD1
For use in Spain 693363-071
For use in Sweden and Finland 693363-B71
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Item Component Spare part number
For use in Switzerland 693363BG1
For use in Taiwan 693363-AB1
For use in Thailand 693363-281
For use in Turkey 693363-141
For use in the United Kingdom and Singapore 693363031
For use in the United States 693363001

Keyboard with pointing stick (includes keyboard cable and pointing stick cable):

For use only on computer models equipped with the Windows 8 Standard and Professional operating system:

For use in Belgium 705613-A41
For use in Brazil 705613-201
For use in Bulgaria 705613-261
For use in Canada 705613-DB1
For use in the Czech Republic and Slovakia 705613-FL1

For use in Denmark 705613-081
For use in France 705613-051
For use in Germany 705613-041
For use in Greece 705613-151
For use in Hungary 705613-211
For use in Iceland 705613-DD1
For use in India 705613-D61
For use in Israel 705613-BB1
For use in Italy 705613-061
For use in Japan 705613-291
For use in Latin America 705613-161
For use in the Netherlands 705613-B31
For use in Norway 705613-091
For use in Northwest Africa 705613-FP1

For use in Portugal 705613-131
For use in Romania 705613-271
For use in Russia 705613-251
For use in Saudi Arabia 705613-171
For use in Slovenia 705613-BA1

Computer major components
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Item Component Spare part number

For use in South Korea 705613-AD1
For use in Spain 705613-071
For use in Sweden and Finland 705613871
For use in Switzerland 705613-BG1
For use in Taiwan 705613-AB1
For use in Thailand 705613-281
For use in Turkey 705613-141
For use in the United Kingdom and Singapore 705613031
For use in the United States 705613-001
For use in Belgium 693362-A41
For use in Brazil 693362-201
For use in Bulgaria 693362-261
For use in Canada 693362-DB1
For use in the Czech Republic and Slovakia 693362-FL1

For use in Denmark 693362-081
For use in France 693362-051
For use in Germany 693362041
For use in Greece 693362-151
For use in Hungary 693362-211
For use in Iceland 693362-DD1
For use in India 693362-D61
For use in Israel 693362-BB1
For use in ltaly 693362-061
For use in Japan 693362-291
For use in Latin America 693362-161
For use in the Netherlands 693362-B31
For use in Norway 693362-091
For use in Northwest Africa 693362-FP1

For use in Portugal 693362-131
For use in Romania 693362-271
For use in Russia 693362-251
For use in Saudi Arabia 693362-171
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Item Component Spare part number
For use in Slovenia 693362-BA1
For use in South Korea 693362-AD1
For use in Spain 693362-071
For use in Sweden and Finland 693362871
For use in Switzerland 693362-BG1
For use in Taiwan 693362-AB1
For use in Thailand 693362-281
For use in Turkey 693362-141
For use in the United Kingdom and Singapore 693362031
For use in the United States 693362001
(3) Top cover (includes TouchPad):
NOTE: The top cover spare part kit includes the TouchPad but does not include a TouchPad cable. The TouchPad
cable is included in the Cable Kit, spare part number 693306-001.
For use on computer models equipped with a fingerprint reader 693317001
For use on computer models not equipped with a fingerprint reader 694507-001
(4) Smart Card reader assembly (includes cable) 693312-001
(5) Media Card reader assembly 693353-001
NOTE: The Media Card reader assembly spare part kit does not include a Media
Card reader assembly cable. The Media Card reader assembly cable is included in
the Cable Kit, spare part number 693306-001.
(6) Fingerprint reader board (includes bracket and cable) 693349-001
(7) System board (includes replacement thermal material):
For use in all countries and regions except the People's Republic of China:
Equipped with an Intel Quad Core i7-3687U 2.10-GHz processor (SC turbo up to 714520-501
3.30-GHz, 1600-MHz FSB, 4.0-MB L3 cache, 17 W) and the Windows 8 Standard
operating system
Equipped with an Intel Quad Core i7-3687U 2.10-GHz processor (SC turbo up to 714520-601
3.30-GHz, 1600-MHz FSB, 4.0-MB L3 cache, 17 W) and the Windows 8
Professional operating system
Equipped with an Intel Quad Core i7-3687U 2.10-GHz processor (SC turbo up to 714520-001
3.30-GHz, 1600-MHz FSB, 4.0-MB L3 cache, 17 W) and the Windows 7
operating system
Equipped with an Intel Quad Core i7-3667U 1.80-GHz processor (SC turbo up to 693360-501
2.90-GHz, 4.0-MB L3 cache, 17 W) and the Windows 8 Standard operating system
Equipped with an Intel Quad Core i7-3667U 1.80-GHz processor (SC turbo up to 693360-601

2.90-GHz, 4.0-MB L3 cache, 17 W) and the Windows 8 Professional

operating system

Computer major components
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Item

Component

Spare part number

Equipped with an Intel Quad Core i7-3667U 1.80-GHz processor (SC turbo up to
2.90-GHz, 4.0-MB L3 cache, 17 W) and the Windows 7 operating system

693360-001

Equipped with an Intel Dual Core i5-3437U 1.90-GHz processor (SC turbo up to
2.90-GHz, 1600-MHz FSB, 3.0-MB L3 cache, 17 W) and the Windows 8 Standard

operating system

714519-501

Equipped with an Intel Dual Core i5-3437U 1.90-GHz processor (SC turbo up to
2.90-GHz, 1600-MHz FSB, 3.0-MB L3 cache, 17 W) and the Windows 8
Professional operating system

714519-601

Equipped with an Intel Dual Core i5-3437U 1.90-GHz processor (SC turbo up to
2.90-GHz, 1600-MHz FSB, 3.0-MB L3 cache, 17 W) and the Windows 7
operating system

714519-001

Equipped with an Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to
2.70-GHz, 3.0-MB L3 cache, 17 W) and the Windows 8 Standard operating system

693358-501

Equipped with an Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to
2.70-GHz, 3.0-MB L3 cache, 17 W) and the Windows 8 Professional
operating system

693358-601

Equipped with an Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to
2.70-GHz, 3.0-MB L3 cache, 17 W) and the Windows 7 operating system

693358-001

Equipped with an Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to
2.60-GHz, 3.0-MB L3 cache, 17 W) and the Windows 8 Standard operating system

693357-501

Equipped with an Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to
2.60-GHz, 3.0-MB L3 cache, 17 W) and the Windows 8 Professional
operating system

693357-601

Equipped with an Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to
2.60-GHz, 3.0-MB L3 cache, 17 W) and the Windows 7 operating system

693357-001

Equipped with an Intel Dual Core i5-3217U 1.70-GHz processor (SC turbo up to
2.60-GHz, 3.0-MB L3 cache, 17 W) and the Windows 8 Standard operating system

693356-501

Equipped with an Intel Dual Core i5-3217U 1.70-GHz processor (SC turbo up to
2.60-GHz, 3.0-MB L3 cache, 17 W) and the Windows 8 Professional

operating system

693356-601

Equipped with an Intel Dual Core i3-3217U 1.80-GHz processor (3.0-MB L3 cache,
17 W) and the Windows 7 operating system

693356-001

For use only in the People's Republic of China:

Equipped with an Intel Quad Core i7-3667U 1.80-GHz processor (SC turbo up to
2.90-GHz, 4.0-MB L3 cache, 17 W) and the Windows 7 operating system

694511-001

Equipped with an Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to
2.70-GHz, 3.0-MB L3 cache, 17 W) and the Windows 7 operating system

694510-001

Equipped with an Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to
2.60-GHz, 3.0-MB L3 cache, 17 W) and the Windows 7 operating system

694509-001

Equipped with an Intel Dual Core i3-3217U 1.80-GHz processor (3.0-MB L3 cache,
17 W) and the Windows 7 operating system

694508-001

®)

Heat sink (includes replacement thermal material)

693307-001
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Item Component Spare part number
(9) Fan (includes cable) 693308001
(10) Speakers (include cables and 4 rubber isolators) 693354-001
(11) RTC battery 651038-001
(12) Power switch board (includes cable) 693352001
(13) Audio board 693351-001

NOTE: The audio board spare part kit does not include an audio board cable. The

audio board cable is included in the Cable Kit, spare part number 693306-001.
(14) Battery (Li-ion):

6-cell, 48-Wh, 2.2-Ah 685988-001

4-cell, 30-Wh, 2.0-Ah 671604-001
(15) Base enclosure (includes battery release latch assembly, rubber feet, and service 693301-001

cover release latch assembly)

Rubber Kit (not illustrated, includes base enclosure and display bezel screw covers)  693355-001
(16) Memory modules (PC3-12800, 1666-MHz, DDR3):

8-GB 670034-001

4-GB 641369-001

2-GB 652972-001
17) WWAN module:

HP hs2350 HSPA+ Mobile Broadband Module 668969001

HP 1t2523 LTE/HSPA+ Mobile Broadband Module 710790-001

HP 1t2522 LTE/EV-DO Mobile Broadband Module 710789-001

HP un2430 EV-DO/HSPA Mini Card 702080-001

HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001
(18) WLAN module:

Atheros AR9462 802.11a/b/g/n 2x2 Bluetooth 4.0 Combo Adapter 676786-001

Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 20702 Bluetooth 4.0 657325-001

Combo Adapter

Intel Centrino Advanced-N 6235 WLAN module 670292001

Intel Centrino Advanced-N 6205 WLAN module 631954-001
19) Hard drive (does not include hard drive bracket, hard drive connector adapter, or screws):

750-GB, 7200-rpm, 9.5-mm 633252-001

500-GB, 7200-rpm, 9.5-mm self-encrypting drive 683801-001

500-GB, 7200-rpm, 9.5-mm 634925-001

320-GB, 7200-rpm, 9.5-mm 641672-001
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Item Component Spare part number

Hard Drive Hardware Kit (not illustrated, includes hard drive bracket, hard drive ~ 693350-001
connector adapter, and screws)

Solid-state drive (not illustrated, does not include bracket, connector, or screws):

256-GB SATA Il self-encrypting solid-state drive 693545-001
240-GB SATA Il solid-state drive 702247-001
180-GB SATA Ill solid-state drive 693544-001
160-GB SATA |l solid-state drive 694673-001
128-GB SATA lll solid-state drive 693543-001
(20) Service cover
Includes label indicating “Made in China” 693315-001
Includes label indicating country of origin 704017-001
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Display assembly subcomponents

Item Component Spare part number
(1) Display bezel:
For use on computer models equipped with a webcam 693302001
For use on computer models not equipped with a webcam 693303-001
(2) 11.6 in, HD, LED, AG, SVA display panel 693361-001
Display Cable Kit, includes: 693305-001
(3) Display panel cable and webcam/microphone module cable
(4) Webcam/microphone module 693318-001
Microphone module 693313-001
Antenna Kit, includes: 693299-001
(5a) WILAN antenna cables and transceivers
(5b) WWAN antenna cables and transceivers

Display assembly subcomponents
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Item Component Spare part number
Display Hinge Cover Kit, includes: 693310001

(6a) Left and right display hinge caps

(6b) Left and right display hinge covers

(6¢) Left and right display hinges

(7) Display enclosure 693300001

(8) Display clutch cover 693311-001
Display Panel Support Kit (not illustrated, includes display enclosure with pre- 693309-001

installed WLAN antenna cables and transceivers and WWAN antenna cables
and transceivers)
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Cable Kit

o— ="

Item Component Spare part number
Cable Kit, includes: 693306-001

(1) Audio board cable

(2) Media Card reader assembly cable

(3) TouchPad cable
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Mass storage devices

Item Description Spare part number
(1) Hard drive (does not include hard drive bracket, hard drive connector adapter, or screws):

750-GB, 7200-rpm, 9.5-mm 633252-001

500-GB, 7200-rpm, 9.5-mm SED 683801-001

500-GB, 7200-rpm, 9.5-mm 634925-001

320-GB, 7200-rpm, 9.5-mm 641672-001

Hard Drive Hardware Kit, includes: 693350-001

(2a) Hard drive bracket

(2b) Hard drive connector adapter

Hard drive bracket screws (not illustrated)

(3) Solid-state drive (does not include solid-state drive bracket, solid-state drive connector adapter, or screws):
256-GB SATA Il self-encrypting solid-state drive 693545001
240-GB SATA Ill solid-state drive 702247-001
180-GB SATA lll solid-state drive 693544-001
160-GB SATA |l solid-state drive 694673001
128-GB SATA Il solid-state drive 693543001
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Miscellaneous parts

Component Spare part number

AC adapter:

65-W HP Smart AC adapter (PFC, RC/V, EM, 3-wire) 693710-001
65-W HP Smart AC adapter (non-PFC, 3-wire) 693711-001
65-W HP travel AC adapter (non-PFC, 3-wire) 693716-001
HP notebook mini sleeve 656839001
HP USB optical travel mouse 434594001
Lock:

HP notebook combination lock 591699001
HP notebook keyed cable lock 626729002

Power cord (3-pin, black, 1.83-m):

For use in Argentina 490371-DO1
For use in Australia 490371011
For use in Brazil 490371-202
For use in Denmark 490371-081
For use in Europe 490371-021
For use in India 490371-D61
For use in Israel 490371-BB1
For use in Japan 490371-291
For use in North America 490371-001
For use in the People's Republic of China 490371-AA1
For use in South Africa 490371-AR1
For use in South Korea 490371-AD1
For use in Switzerland 490371-111
For use in Taiwan 490371-AB1
For use in Thailand 490371-201
For use in the United Kingdom and Singapore 490371-031
Screw Kit 693316001
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Spare part number

Description

434594-001 HP USB optical travel mouse

490371-001 Power cord for use in North America (3-pin, black, 1.83-m)

490371011 Power cord for use in Australia (3-pin, black, 1.83-m)

490371021 Power cord for use in Europe (3-pin, black, 1.83-m)

490371-031 Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.83-m)

490371-081 Power cord for use in Denmark (3-pin, black, 1.83-m)

490371-111 Power cord for use in Switzerland (3-pin, black, 1.83-m)

490371-201 Power cord for use in Thailand (3-pin, black, 1.83-m)

490371-202 Power cord for use in Brazil (3-pin, black, 1.83-m)

490371-291 Power cord for use in Japan (3-pin, black, 1.83-m)

490371-AA1 Power cord for use in the People's Republic of China (3-pin, black, 1.83-m)

490371-AB1 Power cord for use in Taiwan (3-pin, black, 1.83-m)

490371-AD1 Power cord for use in South Korea (3-pin, black, 1.83-m)

490371-AR1 Power cord for use in South Africa (3-pin, black, 1.83-m)

490371-BB1 Power cord for use in Israel (3-pin, black, 1.83-m)

490371-D0O1 Power cord for use in Argentina (3-pin, black, 1.83-m)

490371-D61 Power cord for use in India (3-pin, black, 1.83-m)

591699001 HP notebook combination lock

626729002 HP notebook keyed cable lock

631954001 Intel Centrino Advanced-N 6205 WLAN module

633252001 750-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket, hard drive connector
adapter, or screws)
NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in the
Hard Drive Hardware Kit, spare part number 693350-001.

634400-001 HP un2430 EV-DO/HSPA Mobile Broadband Module

634925-001 500-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket, hard drive connector
adapter, or screws)
NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in the
Hard Drive Hardware Kit, spare part number 693350-001.

641369-001 4-GB memory module (PC3, 12800, 1600-MHz)
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Spare part number  Description

641672001 320-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket, hard drive connector

adapter, or screws)

NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in the
Hard Drive Hardware Kit, spare part number 693350-001.

651038-001 RTC battery

652972-001 2-GB memory module (PC3, 12800, 1600-MHz)

656839-001 HP notebook mini sleeve

657325-001 Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 20702 Bluetooth 4.0 Combo Adapter
668969001 HP hs2350 HSPA+ Mobile Broadband Module

670034-001 8-GB memory module (PC3, 12800, 1600-MHz)

670292-001 Intel Centrino Advanced-N 6235 WLAN module

671604-001 4-cell, 30-Wh, 2.00-Ah, Li-ion battery

676786-001 Atheros AR9462 802.11a/b/g/n 2x2 Bluetooth 4.0 Combo Adapter

683801-001 500-GB, 7200-rpm, 9.5-mm SED hard drive (does not include hard drive bracket, hard drive

connector adapter, or screws)

NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in the

Hard Drive Hardware Kit, spare part number 693350-001.

685988-001 6-cell, 48-Wh, 2.20-Ah, Li-ion battery

693299-001 Antenna Kit (includes WLAN antenna cables and transceivers and WWAN antenna cables
and transceivers)

693300-001 Base enclosure (includes rubber feet, service cover release latch assembly, and battery release
latch assembly)

693301-001 Display enclosure

693302-001 Display bezel for use on computer models equipped with webcam

693303-001 Display bezel for use on computer models not equipped with webcam

693305-001 Display Cable Kit

693306-001 Cable Kit (includes audio board cable, SD Card reader board cable, and TouchPad cable)

693307-001 Heat sink (includes replacement thermal material)

693308-001 Fan (includes cable)

693309-001 Display Panel Support Kit (includes display enclosure with pre-installed WLAN antenna cables and
transceivers and WWAN antenna cables and transceivers)

693310001 Display Hinge Cover Kit (includes left and right display hinges, left and right display hinge caps,
and left and right display hinge covers)

693311001 Display clutch cover

693312-001 Smart Card reader assembly (includes cable)

693313-001 Microphone module
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Spare part number

Description

693315-001 Service cover (includes label indicating “Made in China”)

693316-001 Screw Kit

693317001 Top cover for use on computer models equipped with a fingerprint reader (includes TouchPad)
NOTE: The top cover spare part kit includes the TouchPad but does not include a TouchPad
cable. The TouchPad cable is included in the Cable Kit, spare part number 693306-001.

693318-001 Webcam/microphone module

693349001 Fingerprint reader board (includes bracket and cable)

693350001 Hard Drive Hardware Kit (includes hard drive bracket, hard drive connector adapter, and screws)

693351001 Audio board

693352001 Power switch board (includes cable)

693353001 Media Card reader assembly
NOTE: The Media Card reader assembly spare part kit does not include a Media Card reader
assembly cable. The Media Card reader assembly cable is included in the Cable Kit, spare part
number 693306-001.

693354-001 Speakers (include cables and 4 rubber isolators)

693355001 Rubber Kit (includes base enclosure and display bezel screw covers)

693356-001 System board equipped with an Intel Dual Core i3-3217U 1.80-GHz processor and the Windows 7
operating system for use in all countries and regions except the People's Republic of China and the
Ukraine (3.0-MB L3 cache, 17 W; includes replacement thermal material)

693356-501 System board equipped with an Intel Dual Core i3-3217U 1.80-GHz processor and the Windows 8
Standard operating system for use in all countries and regions except the People's Republic of
China and the Ukraine (3.0-MB L3 cache, 17 W; includes replacement thermal material)

693356-601 System board equipped with an Intel Dual Core i3-3217U 1.80-GHz processor and the Windows 8
Professional operating system for use in all countries and regions except the People's Republic of
China and the Ukraine (3.0-MB L3 cache, 17 W; includes replacement thermal material)

693357001 System board equipped with an Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to
2.60-GHz) and the Windows 7 operating system for use in all countries and regions except the
People's Republic of China and the Ukraine (3.0-MB L3 cache, 17 W; includes replacement
thermal material)

693357-501 System board equipped with an Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to
2.60-GHz) and the Windows 8 Standard operating system for use in all countries and regions
except the People's Republic of China and the Ukraine (3.0-MB L3 cache, 17 W; includes
replacement thermal material)

693357601 System board equipped with an Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to
2.60-GHz) and the Windows 8 Professional operating system for use in all countries and regions
except the People's Republic of China and the Ukraine (3.0-MB L3 cache, 17 W; includes
replacement thermal material)

693358-001 System board equipped with an Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to

2.70-GHz) and the Windows 7 operating system for use in all countries and regions except the
People's Republic of China and the Ukraine (3.0-MB L3 cache, 17 W; includes replacement
thermal material)
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Spare part number  Description

693358-501 System board equipped with an Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to
2.70-GHz) and the Windows 8 Standard operating system for use in all countries and regions
except the People's Republic of China and the Ukraine (3.0-MB L3 cache, 17 W; includes
replacement thermal material)

693358-601 System board equipped with an Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to
2.70-GHz) and the Windows 8 Professional operating system for use in all countries and regions
except the People's Republic of China and the Ukraine (3.0-MB L3 cache, 17 W; includes
replacement thermal material)

693360-001 System board equipped with an Intel Dual Core i7-3667U 1.80-GHz processor (SC turbo up to
2.90-GHz) and the Windows 7 operating system for use in all countries and regions except the
People's Republic of China and the Ukraine (4.0-MB L3 cache, 17 W; includes replacement
thermal material)

693360-501 System board equipped with an Intel Dual Core i7-3667U 1.80-GHz processor (SC turbo up to
2.90-GHz) and the Windows 8 Standard operating system for use in all countries and regions
except the People's Republic of China and the Ukraine (4.0-MB L3 cache, 17 W; includes
replacement thermal material)

693360601 System board equipped with an Intel Dual Core i7-3667U 1.80-GHz processor (SC turbo up to
2.90-GHz) and the Windows 8 Professional operating system for use in all countries and regions
except the People's Republic of China and the Ukraine (4.0-MB L3 cache, 17 W; includes
replacement thermal material)

693361-001 11.6 in, HD, LED, AG, SVA display panel

693362-001 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in the United States (includes keyboard cable and pointing stick cable)

693362-031 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in the United Kingdom and Singapore (includes keyboard cable and pointing
stick cable)

693362041 Keyboard with pointing stick for use on computer models equipped with the Windows 7

operating system in Germany (includes keyboard cable and pointing stick cable)

693362-051 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in France (includes keyboard cable and pointing stick cable)

693362-061 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in ltaly (includes keyboard cable and pointing stick cable)

693362071 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Spain (includes keyboard cable and pointing stick cable)

693362081 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Denmark (includes keyboard cable and pointing stick cable)

693362091 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Norway (includes keyboard cable and pointing stick cable)

693362-131 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Portugal (includes keyboard cable and pointing stick cable)

693362-141 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Turkey (includes keyboard cable and pointing stick cable)

693362-151 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Greece (includes keyboard cable and pointing stick cable)
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693362-161 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Latin America (includes keyboard cable and pointing stick cable)
693362-171 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Saudi Arabia (includes keyboard cable and pointing stick cable)
693362-201 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Brazil (includes keyboard cable and pointing stick cable)
693362211 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Hungary (includes keyboard cable and pointing stick cable)
693362-251 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Russia (includes keyboard cable and pointing stick cable)
693362-261 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Bulgaria (includes keyboard cable and pointing stick cable)
693362271 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Romania (includes keyboard cable and pointing stick cable)
693362281 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Thailand (includes keyboard cable and pointing stick cable)
693362291 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Japan (includes keyboard cable and pointing stick cable)
693362-A41 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Belgium (includes keyboard cable and pointing stick cable)
693362-AB1 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Taiwan (includes keyboard cable and pointing stick cable)
693362-AD1 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in South Korea (includes keyboard cable and pointing stick cable)
693362831 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in the Netherlands (includes keyboard cable and pointing stick cable)
693362871 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Sweden and Finland (includes keyboard cable and pointing stick cable)
693362-BA1 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Slovenia (includes keyboard cable and pointing stick cable)
693362-BB1 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Israel (includes keyboard cable and pointing stick cable)
693362-BG1 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Switzerland (includes keyboard cable and pointing stick cable)
693362-D61 Keyboard with pointing stick for use in on computer models equipped with the Windows 7
operating system India (includes keyboard cable and pointing stick cable)
693362-DB1 Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Canada (includes keyboard cable and pointing stick cable)
693362-DD1 Keyboard with pointing stick for use on computer models equipped with the Windows 7

operating system in Iceland (includes keyboard cable and pointing stick cable)
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693362-FL1

Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in the Czech Republic and Slovakia (includes keyboard cable and pointing
stick cable)

693362-FP1

Keyboard with pointing stick for use on computer models equipped with the Windows 7
operating system in Northwest Africa (includes keyboard cable and pointing stick cable)

693363-001

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in the United States (includes keyboard cable and pointing
stick cable)

693363-031

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in the United Kingdom and Singapore (includes keyboard cable and
pointing stick cable)

693363-041

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Germany (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-051

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in France (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-061

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in ltaly (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-071

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Spain (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-081

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Denmark (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-091

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Norway (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-131

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Portugal (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-141

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Turkey (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-151

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Greece (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-161

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Latin America (includes keyboard cable, backlight cable, and
pointing stick cable)

693363-171

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Saudi Arabia (includes keyboard cable, backlight cable, and
pointing stick cable)
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693363-201

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Brazil (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-211

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Hungary (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-251

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Russia (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-261

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Bulgaria (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-271

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Romania (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-281

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Thailand (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-291

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Japan (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-A41

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Belgium (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-AB1

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Taiwan (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-AD1

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in South Korea (includes keyboard cable, backlight cable, and
pointing stick cable)

693363831

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in the Netherlands (includes keyboard cable, backlight cable, and
pointing stick cable)

693363871

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Sweden and Finland (includes keyboard cable, backlight cable,
and pointing stick cable)

693363-BA1

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Slovenia (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-BB1

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Israel (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-BG1

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Switzerland (includes keyboard cable, backlight cable, and
pointing stick cable)
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693363-D61 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in India (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-DB1 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Canada (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-DD1 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Iceland (includes keyboard cable, backlight cable, and pointing
stick cable)

693363-FL1 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in the Czech Republic and Slovakia (includes keyboard cable,
backlight cable, and pointing stick cable)

693363-FP1 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 7 operating system in Northwest Africa (includes keyboard cable, backlight cable, and
pointing stick cable)

693543-001 128-GB SATA lll solid-state drive

693544-001 180-GB SATA lll solid-state drive

693545001 256-GB SATA Il self-encrypting solid-state drive

693710-001 65-W HP Smart AC adapter (RC/V, EM, 3-wire)

693711-001 65-W HP Smart AC adapter (non-PFC, 3-wire)

693716-001 65-W HP travel AC adapter (non-PFC, 3-wire)

694507-001 Top cover for use on computer models not equipped with a fingerprint reader (includes TouchPad)

NOTE: The top cover spare part kit includes the TouchPad but does not include a TouchPad
cable. The TouchPad cable is included in the Cable Kit, spare part number 693306-001.

694508-001 System board equipped with Intel Dual Core i3-3217U 1.80-GHz processor for use only in the
People's Republic of China (3.0-MB L3 cache, 17 W; includes replacement thermal material)

694509-001 System board equipped with Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to 2.60-
GHz) for use only in the People's Republic of China (3.0-MB L3 cache, 17 W; includes replacement
thermal material)

694510-001 System board equipped with Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to 2.70-
GHz) for use only in the People's Republic of China (3.0-MB L3 cache, 17 W; includes replacement
thermal material)

694511-001 System board equipped with Intel Dual Core i7-3667U 1.80-GHz processor (SC turbo up to 2.90-
GHz) for use only in the People's Republic of China (4.0-MB L3 cache, 17 W; includes replacement
thermal material)

694512001 Processor bracket

694673-001 160-GB SATA |l solid-state drive

702080-001 HP un2430 EV-DO/HSPA Mini Card

702247-001 240-GB SATA Il solid-state drive

704017001 Service cover (includes label indicating country of origin)
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705613001 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in the United States (includes keyboard cable and pointing
stick cable)

705613-031 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard

or Professional operating system in the United Kingdom and Singapore (includes keyboard cable
and pointing stick cable)

705613-041 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Germany (includes keyboard cable and pointing stick cable)
705613-051 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in France (includes keyboard cable and pointing stick cable)
705613061 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in ltaly (includes keyboard cable and pointing stick cable)
705613071 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Spain (includes keyboard cable and pointing stick cable)
705613081 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Denmark (includes keyboard cable and pointing stick cable)
705613091 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Norway (includes keyboard cable and pointing stick cable)
705613-131 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Portugal (includes keyboard cable and pointing stick cable)
705613-141 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Turkey (includes keyboard cable and pointing stick cable)
705613-151 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Greece (includes keyboard cable and pointing stick cable)
705613-161 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Latin America (includes keyboard cable and pointing
stick cable)
705613-171 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard

or Professional operating system in Saudi Arabia (includes keyboard cable and pointing stick cable)

705613-201 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Brazil (includes keyboard cable and pointing stick cable)

705613-211 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Hungary (includes keyboard cable and pointing stick cable)

705613-251 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Russia (includes keyboard cable and pointing stick cable)

705613-261 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Bulgaria (includes keyboard cable and pointing stick cable)

705613-271 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Romania (includes keyboard cable and pointing stick cable)

705613-281 Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Thailand (includes keyboard cable and pointing stick cable)
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705613-291

Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Japan (includes keyboard cable and pointing stick cable)

705613-A41

Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Belgium (includes keyboard cable and pointing stick cable)

705613-AB1

Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Taiwan (includes keyboard cable and pointing stick cable)

705613-AD1

Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in South Korea (includes keyboard cable and pointing stick cable)

705613-B31

Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in the Netherlands (includes keyboard cable and pointing
stick cable)

705613-B71

Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Sweden and Finland (includes keyboard cable and pointing
stick cable)

705613-BA1

Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Slovenia (includes keyboard cable and pointing stick cable)

705613-BB1

Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Israel (includes keyboard cable and pointing stick cable)

705613-BG1

Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Switzerland (includes keyboard cable and pointing stick cable)

705613-D61

Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in India (includes keyboard cable and pointing stick cable)

705613-DB1

Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Canada (includes keyboard cable and pointing stick cable)

705613-DD1

Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Iceland (includes keyboard cable and pointing stick cable)

705613-FL1

Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in the Czech Republic and Slovakia (includes keyboard cable and
pointing stick cable)

705613-FP1

Keyboard with pointing stick for use on computer models equipped with the Windows 8 Standard
or Professional operating system in Northwest Africa (includes keyboard cable and pointing
stick cable)

705614-001

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in the United States (includes keyboard
cable, backlight cable, and pointing stick cable)

705614-031

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in the United Kingdom and Singapore
(includes keyboard cable, backlight cable, and pointing stick cable)

705614-041

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Germany (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-051

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in France (includes keyboard cable,
backlight cable, and pointing stick cable)
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705614061 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in ltaly (includes keyboard cable, backlight
cable, and pointing stick cable)

705614-071 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Spain (includes keyboard cable, backlight
cable, and pointing stick cable)

705614-081 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Denmark (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-091 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Norway (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-131 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Portugal (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-141 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Turkey (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-151 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Greece (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-161 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Latin America (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-171 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Saudi Arabia (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-201 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Brazil (includes keyboard cable, backlight
cable, and pointing stick cable)

705614211 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Hungary (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-251 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Russia (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-261 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Bulgaria (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-271 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Romania (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-281 Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Thailand (includes keyboard cable,
backlight cable, and pointing stick cable)
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705614-291

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Japan (includes keyboard cable, backlight
cable, and pointing stick cable)

705614-A41

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Belgium (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-AB1

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Taiwan (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-AD1

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in South Korea (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-B31

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in the Netherlands (includes keyboard
cable, backlight cable, and pointing stick cable)

705614-B71

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Sweden and Finland (includes keyboard
cable, backlight cable, and pointing stick cable)

705614-BA1

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Slovenia (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-BB1

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Israel (includes keyboard cable, backlight
cable, and pointing stick cable)

705614-BG1

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Switzerland (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-D61

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in India (includes keyboard cable, backlight
cable, and pointing stick cable)

705614-DB1

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Canada (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-DD1

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Iceland (includes keyboard cable,
backlight cable, and pointing stick cable)

705614-FL1

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in the Czech Republic and Slovakia
(includes keyboard cable, backlight cable, and pointing stick cable)

705614-FP1

Keyboard with backlight and pointing stick for use on computer models equipped with the
Windows 8 Standard or Professional operating system in Northwest Africa (includes keyboard
cable, backlight cable, and pointing stick cable)

710789-001

HP 1t2522 LTE/EV-DO Mobile Broadband Module

710790-001

HP 1t2523 LTE/HSPA+ Mobile Broadband Module
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713763-001

500-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket, hard drive connector

adapter, or screws)

NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in the
Hard Drive Hardware Kit, spare part number 693350-001.

714519-001

System board equipped with an Intel Dual Core i5-3437U 1.90-GHz (SC turbo up to 2.90-GHz)
processor and the Windows 7 operating system for use in all countries and regions (1600-MHz
FSB, 3.0-MB L3 cache, 17 W; includes replacement thermal material)

714519-501

System board equipped with an Intel Dual Core i5-3437U 1.90-GHz (SC turbo up to 2.90-GHz)
processor and the Windows 8 Standard operating system for use in all countries and regions
(1600-MHz FSB, 3.0-MB L3 cache, 17 W; includes replacement thermal material)

714519-601

System board equipped with an Intel Dual Core i5-3437U 1.90-GHz (SC turbo up to 2.90-GHz)
processor and the Windows 8 Professional operating system for use in all countries and regions
(1600-MHz FSB, 3.0-MB L3 cache, 17 W; includes replacement thermal material)

714520-001

System board equipped with an Intel Quad Core i7-3687U 2.10-GHz (SC turbo up to 3.30-GHz)
processor and the Windows 7 operating system for use in all countries and regions (1600-MHz
FSB, 4.0-MB L3 cache, 17 W; includes replacement thermal material)

714520-501

System board equipped with an Intel Quad Core i7-3687U 2.10-GHz (SC turbo up to 3.30-GHz)
processor and the Windows 8 Standard operating system for use in all countries and regions

(1600-MHz FSB, 4.0-MB L3 cache, 17 W; includes replacement thermal material)

714520-601

System board equipped with an Intel Quad Core i7-3687U 2.10-GHz (SC turbo up to 3.30-GHz)
processor and the Windows 8 Professional operating system for use in all countries and regions

(1600-MHz FSB, 4.0-MB L3 cache, 17 W; includes replacement thermal material)
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

Flat-bladed screw driver

®  Magnetic screw driver

Phillips PO and P1 screw drivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

E‘/fNOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

/\ CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

Cables and connectors

/\ CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.
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Drive handling

/\ CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the

computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the
operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage
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Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.
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/\ CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described

in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by

different activities.

/\ CAUTION: A product can be degraded by as litle as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500V
Walking across vinyl floor 12,000 V 5,000 V 3,000 V
Motions of bench worker 6,000 V 800V 400V
Removing DIPS from plastic tube 2,000V 700V 400V
Removing DIPS from vinyl tray 11,500 V 4,000 vV 2,000V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000V
Packing PCBs in foam-lined box 21,000V 11,000 V 5,000 V

Preliminary replacement requirements
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

Place items on a grounded surface before removing items from their containers.

Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines
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Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

Use conductive field service tools, such as cutters, screw drivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm +10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

Antistatic tape

Antistatic smocks, aprons, and sleeve protectors

Conductive bins and other assembly or soldering aids
Nonconductive foam

Conductive tabletop workstations with ground cords of one megohm resistance
Static-dissipative tables or floor mats with hard ties to the ground
Field service kits

Static awareness labels

Material-handling packages

Nonconductive plastic bags, tubes, or boxes

Metal tote boxes

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastics Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000 V

Preliminary replacement requirements
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Component replacement procedures

This chapter provides removal and replacement procedures.

There are as many as 61 screws that must be removed, replaced, and/or loosened when servicing the
computer. Make special note of each screw size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag. It is necessary to remove the battery to obtain these numbers. See Battery
on page 56 for battery removal instructions.

?

® |

Serial: J0000C00C (IR W@AMEmEW
—Product: XXO0000XX |IINMMEMNINNNNIN

__Warranty: 1ylyOy
| Model: XX0000(X

Item Component Description

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about the

product’s hardware components. The part number helps
a service technician determine what components and
parts are needed.
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Item Component Description

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.

Computer feet

The computer feet are adhesive-backed rubber pads. There are four rectangular rubber feet that attach
to the base enclosure in the locations illustrated below.

The feet are included in the Rubber Kit, spare part number 693355-001.
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Battery

Description Spare part number
6-cell, 48-Wh, 2.2-Ah 685988-001
4-cell, 30-Wh, 2.0-Ah 671604-001

Before disassembling the computer, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

Remove the battery:

1. Position the computer upside-down on a flat surface, with the battery bay toward you.

2. Slide the battery lock latch (1), and then slide the battery release latch (2) to release the battery.

3. Remove the battery (3) from the computer.

Install the battery by inserting it into the battery bay until you hear a click. The battery lock latch and the
battery release latch automatically reset when the battery is installed.
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SIM

@NOTE: This section applies only to computer models with WWAN capability.

@’NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 56).

Remove the SIM:
1. Press in on the SIM (1). (The SIM partially ejects from the SIM slot.)
2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Service cover

Description Spare part number
Includes label indicating “Made in China” 693315-001
Includes label indicating country of origin 704017-001

Before removing the service cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 56).

Remove the service cover:
1. Loosen the two Phillips PM2.0x5.5 screws (1) that secure the service cover to the computer.
2. Slide the service cover (2) forward to disengage the cover from the computer.

3. Remove the service cover (3) by lifting it straight up and away from the computer.

Reverse the removal procedures to install the service cover.
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Hard drive

E’%NOTE: The hard drive spare part kit does not include the hard drive bracket, hard drive connector
adapter, or screws.

Description Spare part number
750-GB, 7200-rpm, 9.5-mm 633252-001
500-GB, 7200-rpm, 9.5-mm SED 683801-001
500-GB, 7200-rpm, 9.5-mm 634925-001
320-GB, 7200-rpm, 9.5-mm 641672-001
Hard Drive Hardware Kit (includes the hard drive bracket, hard drive connector adapter, and 693350-001

screws)

Before removing the hard drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.

Remove the battery (see Battery on page 56).

2.
3. Disconnect all external devices from the computer.
4.
5.

Remove the service cover (see Service cover on page 58).

Remove the hard drive:

1. Loosen the four Phillips PM2.0x5.5 screws (1) that secure the hard drive to the computer.
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2. Use the hard drive tab (2) to disconnect the hard drive from the system board and remove the
hard drive from the computer.

3. Ifitis necessary to disassemble the hard drive, perform the following steps:
a. Position the hard drive with the connector toward you.
b. Disconnect the hard drive connector adapter (1) from the hard drive.

c. Remove the four Phillips PM2.9x4.1 screws (2) that secure the hard drive bracket to the
hard drive.

d. Lift the left side of the hard drive bracket (3) until it rests at an angle.
e. Remove the hard drive bracket (4) from the hard drive.

The hard drive bracket, hard drive connector adapter, and screws are available in the Hard
Drive Hardware Kit, spare part number 693350-001.
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Reverse this procedure to reassemble and install the hard drive.

Fingerprint reader board

Description Spare part number

Fingerprint reader board (includes bracket and cable) 693349-001

Before removing the fingerprint reader board, follow these steps:

1.

o U s W N

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.
Disconnect all external devices from the computer.

Remove the battery (see Battery on page 56).

Remove the service cover (see Service cover on page 58).

Remove the hard drive (see Hard drive on page 59).

Remove the fingerprint reader board:

1.

Release the zero insertion force (ZIF) connector to which the fingerprint reader board cable is
attached, and then disconnect the fingerprint reader board cable (1) from the SD Card
reader board.

Remove the Phillips PM2.0x2.0 screw (2) that secures the fingerprint reader board bracket to the
top cover.
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3. Lift the rear edge of the fingerprint reader board bracket (3), and then remove the bracket.

4. Remove the fingerprint reader board and cable (4).

Reverse this procedure to install the fingerprint reader board.

WLAN module
Description Spare part number
Atheros AR9462 802.11a/b/g/n 2x2 Bluetooth 4.0 Combo Adapter 676786-001
Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 20702 Bluetooth 4.0 Combo Adapter 657325-001
Intel Centrino Advanced-N 6235 WLAN module 670292-001
Intel Centrino Advanced-N 6205 WLAN module 631954-001

/\ CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.
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4. Remove the battery (see Battery on page 56).

5. Remove the service cover (see Service cover on page 58).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

@NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal
labeled “1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal
labeled “2”. If the computer is equipped with an 802.11a/b/g/n WLAN module, the yellow
WLAN antenna cable connects to the middle terminal on the WLAN module.

2. Remove the Phillips PM2.0x3.0 screw (2) that secures the WLAN module to the base enclosure.
(The WLAN module tilts up.)

3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

E’%NOTE: If the WLAN antenna cables are not connected to the terminals on the WLAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.
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Reverse this procedure fo install the WLAN module.

WWAN module

@NOTE: The WWAN module and the WLAN module are not interchangeable.

Description Spare part number
HP hs2350 HSPA+ Mobile Broadband Module 668969001
HP {2523 LTE/HSPA+ Mobile Broadband Module 710790-001
HP 12522 LTE/EV-DO Mobile Broadband Module 710789-001
HP un2430 EV-DO/HSPA Mini Card 702080-001
HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

Before removing the WWAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.

Remove the battery (see Battery on page 56).

2
3. Disconnect all external devices from the computer.
4
5

Remove the service cover (see Service cover on page 58).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

E"/f'NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal.
The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the Phillips PM2.0x3.0 screw (2) that secures the WWAN module to the base enclosure.
(The WWAN module tilts up.)
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3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

E‘/f'NOTE: If the WWAN antenna cables are not connected to the terminals on the WWAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WWAN module.
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Memory module

@NOTE: Primary and expansion memory is installed in a stacked configuration in the bottom of
the computer.

Description Spare part number
8-GB memory module (PC3, 12800, 1600-MHz) 670034-001
4-GB memory module (PC3, 12800, 1600-MHz) 641369-001
2-GB memory module (PC3, 12800, 1600-MHz) 652972-001

Update BIOS before adding memory modules

Before adding new memory, make sure you update the computer to the latest BIOS.

/\ CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.

To update BIOS:

1.
2,
3.

4
5
6.
7
8

Navigate to www.hp.com.
Click Support & Drivers > click Drivers & Software.

In the Enter a product name/number box, type the computer model information, and then
click Search.

Click the link for the computer model.

Select the operating system, and then click Next.

Under Step 2: Select a Download, click the BIOS link.
Click the link for the most recent BIOS.

Click the Download button, and then follow the on-screen instructions.

Before removing a memory module, follow these steps:

1.

2
3.
4
5

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.
Disconnect all external devices from the computer.

Remove the battery (see Battery on page 56).

Remove the service cover (see Service cover on page 58).

Remove the memory module:

1.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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2. Remove the memory module (2) by pulling the module away from the slot at an angle.

@NOTE: The computer uses two memory slots. The top slot houses the expansion memory module.
The bottom slot houses the primary memory module.

Reverse this procedure to install @ memory module.
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Fan

Description Spare part number

Fan (includes cable) 693308-001

Before removing the fan, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.

Remove the battery (see Battery on page 56).

2,
3. Disconnect all external devices from the computer.
4.
5.

Remove the service cover (see Service cover on page 58).

Remove the fan:
1. Disconnect the fan cable (1) from the system board.
2. Remove the two Phillips PM2.0x3.4 screws (2) that secure the fan to the top cover.

3. Lift the left side of the fan (3) until it rests at an angle, and then remove the fan.

Reverse this procedure to install the fan.
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Keyboard

For use in country/region Spare part For use in country/region Spare part
number number

Keyboard with backlight and pointing stick (includes keyboard cable, backlight cable, and pointing stick cable):

For use only on computer models equipped with the Windows ~ For use in the Netherlands 705614831
8 Standard and Professional operating system:
For use in Belgium 705614-A41 For use in Norway 705614-091
For use in Brazil 705614-201 For use in Northwest Africa 705614-FP1
For use in Bulgaria 705614-261 For use in Portugal 705614-131
For use in Canada 705614-DB1 For use in Romania 705614-271
For use in the Czech Republic 705614-FL1 For use in Russia 705614251
and Slovakia
For use in Denmark 705614-081 For use in Saudi Arabia 705614-171
For use in France 705614-051 For use in Slovenia 705614-BA1
For use in Germany 705614-041 For use in South Korea 705614-AD1
For use in Greece 705614-151 For use in Spain 705614-071
For use in Hungary 705614-211 For use in Sweden and Finland 705614-B71
For use in Iceland 705614-DD1 For use in Switzerland 705614BG1
For use in India 705614-D61 For use in Taiwan 705614-AB1
For use in Israel 705614-BB1 For use in Thailand 705614-281
For use in ltaly 705614-061 For use in Turkey 705614-141
For use in Japan 705614291 For use in the United Kingdom 705614031
and Singapore
For use in Latin America 705614-161 For use in the United States 705614001
For use only on computer models equipped with the Windows  For use in the Netherlands 693363-B31
7 operating system:
For use in Belgium 693363-A41 For use in Norway 693363-091
For use in Brazil 693363-201 For use in Northwest Africa 693363-FP1
For use in Bulgaria 693363-261 For use in Portugal 693363-131
For use in Canada 693363-DB1 For use in Romania 693363-271
For use in the Czech Republic 693363-FL1 For use in Russia 693363-251
and Slovakia
For use in Denmark 693363-081 For use in Saudi Arabia 693363-171
For use in France 693363-051 For use in Slovenia 693363-BA1
For use in Germany 693363-041 For use in South Korea 693363-AD1
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For use in country/region Spare part For use in country/region Spare part
number number
For use in Greece 693363-151 For use in Spain 693363-071
For use in Hungary 693363211 For use in Sweden and Finland 693363871
For use in Iceland 693363-DD1 For use in Switzerland 693363-BG1
For use in India 693363-D61 For use in Taiwan 693363-AB1
For use in Israel 693363-BB1 For use in Thailand 693363-281
For use in ltaly 693363-061 For use in Turkey 693363-141
For use in Japan 693363291 For use in the United Kingdom 693363031
and Singapore
For use in Latin America 693363-161 For use in the United States 693363001
Keyboard with pointing stick (includes keyboard cable and pointing stick cable):
For use only on computer models equipped with the Windows  For use in the Netherlands 705613-B31
8 Standard and Professional operating system:
For use in Belgium 705613-A41 For use in Norway 705613-091
For use in Brazil 705613201 For use in Northwest Africa 705613-FP1
For use in Bulgaria 705613261 For use in Portugal 705613-131
For use in Canada 705613-DB1 For use in Romania 705613-271
For use in the Czech Republic 705613FL1 For use in Russia 705613251
and Slovakia
For use in Denmark 705613-081 For use in Saudi Arabia 705613-171
For use in France 705613-051 For use in Slovenia 705613-BA1
For use in Germany 705613-041 For use in South Korea 705613-AD1
For use in Greece 705613-151 For use in Spain 705613-071
For use in Hungary 705613211 For use in Sweden and Finland 705613871
For use in Iceland 705613-DD1 For use in Switzerland 705613-BG1
For use in India 705613-D61 For use in Taiwan 705613-AB1
For use in Israel 705613-BB1 For use in Thailand 705613-281
For use in Italy 705613-061 For use in Turkey 705613-141
For use in Japan 705613291 For use in the United Kingdom 705613031
and Singapore
For use in Latin America 705613-161 For use in the United States 705613001
For use only on computer models equipped with the Windows  For use in the Netherlands 693362-B31
7 operating system:
For use in Belgium 693362-A41 For use in Norway 693362-091
For use in Brazil 693362-201 For use in Northwest Africa 693362-FP1
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For use in country/region Spare part For use in country/region Spare part
number number

For use in Bulgaria 693362-261 For use in Portugal 693362-131
For use in Canada 693362-DB1 For use in Romania 693362-271
For use in the Czech Republic 693362-FL1 For use in Russia 693362-251
and Slovakia

For use in Denmark 693362-081 For use in Saudi Arabia 693362-171
For use in France 693362-051 For use in Slovenia 693362-BA1
For use in Germany 693362-041 For use in South Korea 693362-AD1
For use in Greece 693362-151 For use in Spain 693362-071
For use in Hungary 693362-211 For use in Sweden and Finland 693362-B71
For use in Iceland 693362-DD1 For use in Switzerland 693362BG1
For use in India 693362-D61 For use in Taiwan 693362-AB1
For use in Israel 693362-BB1 For use in Thailand 693362281
For use in ltaly 693362-061 For use in Turkey 693362-141
For use in Japan 693362291 For use in the United Kingdom 693362031

and Singapore

For use in Latin America 693362-161 For use in the United States 693362-001

Before removing the keyboard, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

o A O DN

Remove the battery (see Battery on page 56).

Disconnect all external devices from the computer.

Remove the service cover (see Service cover on page 58).

. Disconnect the power from the computer by unplugging the power cord from the computer.
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Remove the keyboard:

1. Loosen the four Phillips captive screws that secure the keyboard to the computer.

2. Rest and secure the computer on its left side.

3. Partially open the computer.
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4.
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Insert a screw driver or similar thin tool into the keyboard release opening in the battery bay, and
then press on the back of the keyboard until the keyboard disengages from the computer.

3

e
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Turn the computer rightside up with the front toward you.
Open the computer.
Lift the rear edge of the keyboard (1) until the keyboard rests at an angle.

Slide the keyboard (2) toward the display until the tabs on the front edge of the keyboard
disengage from the slots in the top cover.
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9. Swing the top edge of the keyboard up and forward (3) until it rests upside down on the
palm rest.

[Bf NOTE:  The keyboard backlight cable is present on select models only.

10. Release the ZIF connector (1) to which the keyboard backlight cable is attached, and then
disconnect the keyboard backlight cable (2) from the system board.

11. Release the ZIF connector (3) to which the keyboard cable is attached, and then disconnect the
keyboard cable (4) from the system board.
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12. Release the ZIF connector (5) to which the pointing stick cable is attached, and then disconnect
the pointing stick cable (6) from the system board.

13. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Base enclosure

Description Spare part number

Base enclosure (includes battery release latch assembly, rubber feet, and service cover release 693301-001
latch assembly)

Before removing the base enclosure, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 56), and then remove the following components:

a. Service cover (see Service cover on page 58)

b. Hard drive (see Hard drive on page 59)

¢.  WILAN module (see WLAN module on page 62)

d. WWAN module (see WWAN module on page 64)

e. Keyboard (see Keyboard on page 69)

@NOTE: When replacing the base enclosure, be sure to remove the following components from the
defective base enclosure and install them on the replacement base enclosure:

e Audio board (see Audio board on page 80)

e  Speakers (see Speakers on page 81)

e  Power switch board (see Power switch board on page 83)

Remove the base enclosure:
1. Close the computer.

2. Turn the computer upside down, with the front toward you.
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3. Disconnect the following cables from the system board:
(1) Display panel cable
(2) Power switch board cable
(3) Speaker cable
(4) Audio board cable

4. Release the display panel cable and wireless antenna cables (1) from the clips (2) and routing
channels built info the base enclosure.
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5. Remove the two rubber screw covers (1) and (2) in the rear corners of the base enclosure.

The rubber screw covers are included in the Rubber Kit, spare part number 693355-001.

E’%NOTE: The rubber screw covers are different sizes. The longer rubber screw cover (2) should be
installed in the rear/right corner.

6. Remove the ten Torx TM2.0x5.6 screws (3) that secure the base enclosure to the computer.

7. Remove the two Torx TM2.0x3.7 screws from the docking station alignment guide holes that
secure the base enclosure to the computer.

8. Position the computer with the front toward you.
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9. Disengage the base enclosure (1) from the top cover, making sure to guide the leftside wireless
antenna cables (2) through the base enclosure left-side opening (3) and the rightside wireless
antenna cables (4) through the base enclosure right-side opening (5).

10. Remove the base enclosure

Reverse this procedure to install the base enclosure.
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Audio board

@NOTE: The audio board spare part kit does not include an audio board cable. The audio board
cable is included in the Cable Kit, spare part number 693306-001.
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Description Spare part number

Audio board 693351-001

Before removing the audio board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 56), and then remove the following components:

b.

e.

f.

Service cover (see Service cover on page 58)

Hard drive (see Hard drive on page 59)

WILAN module (see WLAN module on page 62)

WWAN module (see WWAN module on page 64)

Keyboard (see Keyboard on page 69)

Base enclosure (see Base enclosure on page 76)

Remove the audio board:

1. Turn the base enclosure right side up, with the front toward you.

2. Remove the Phillips PM2.0x3.7 screw (1) that secures the audio board to the base enclosure.

3. Lift the right side of the audio board (2) until it rests at an angle.
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4.

Remove the audio board (3) and cable.

Reverse this procedure to install the audio board.

Speakers

Description Spare part number

Speakers (include cables and 4 rubber isolators) 655792001

Before removing the speakers, follow these steps:

1.

Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect the power from the computer by unplugging the power cord from the computer.
Disconnect all external devices from the computer.

Remove the battery (see Battery on page 56), and then remove the following components:

a. Service cover (see Service cover on page 58)

b. Hard drive (see Hard drive on page 59)

c.  WILAN module (see WLAN module on page 62)

d. WWAN module (see WWAN module on page 64)

e. Keyboard (see Keyboard on page 69)

f. Base enclosure (see Base enclosure on page 76)
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Remove the speakers:
1. Turn the base enclosure right side up, with the front foward you.
Release the speaker cable (1) from the clips built into the base enclosure.

2
3. Remove the four Phillips PM2.5x5.9 screws (2) that secure the speakers to the base enclosure.
4

Remove the speakers (3).

r__f"%NOTE: The speakers include four rubber isolators that are installed in the screw holes (4). These
isolators are crucial to the performance of the speakers.

Reverse this procedure to install the speakers.
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Power switch board

Description Spare part number

Power switch board (includes cable) 693352-001

Before removing the power switch board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 56), and then remove the following components:

b.

e.

f.

Service cover (see Service cover on page 58)

Hard drive (see Hard drive on page 59)

WLAN module (see WLAN module on page 62)

WWAN module (see WWAN module on page 64)

Keyboard (see Keyboard on page 69)

Base enclosure (see Base enclosure on page 76)

Remove the power switch board:

1. Turn the base enclosure right side up, with the front toward you.

2. Remove the Phillips PM2.0x3.4 screw (1) that secures the power switch board to the
base enclosure.
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3. Remove the power switch board (2).

Reverse this procedure to install the power switch board.

Media Card reader assembly

@NOTE: The Media Card reader assembly spare part kit does not include a Media Card reader
assembly cable. The Media Card reader assembly cable is included in the Cable Kit, spare part

number 693306-001.
Description Spare part number
Media Card reader assembly 693353001

Before removing the Media Card reader assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 56), and then remove the following components:

a. Service cover (see Service cover on page 58)

b. Hard drive (see Hard drive on page 59)

c.  WIAN module (see WLAN module on page 62)

d. WWAN module (see WWAN module on page 64)
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e. Keyboard (see Keyboard on page 69)

f. Base enclosure (see Base enclosure on page 76)

Remove the Media Card reader assembly:

1. Release the ZIF connector to which the fingerprint reader board cable is attached, and then
disconnect the fingerprint reader board cable (1) from the Media Card reader assembly.

2. Remove the two Phillips PM2.0x3.4 screws (1) that secure the Media Card reader assembly to
the top cover.

3. Lift the front edge of the Media Card reader assembly (1), and then swing the assembly (2) up
and to the left.
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4. Release the ZIF connector to which the Media Card reader assembly cable is attached, and then
disconnect the Media Card reader assembly cable (3) from the Media Card reader assembly.

5. Remove the Media Card reader assembly.

Reverse this procedure to install the Media Card reader assembly.

RTC battery

Description Spare part number

RTC battery 651038-001

Before removing the RTC battery, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 56), and then remove the following components:

a. Service cover (see Service cover on page 58)

b. Hard drive (see Hard drive on page 59)

c.  WIAN module (see WLAN module on page 62)

d. WWAN module (see WWAN module on page 64)
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e. Keyboard (see Keyboard on page 69)

f. Base enclosure (see Base enclosure on page 76)

Remove the RTC battery:

A Use a thin, non-conductive tool (1) to remove the RTC battery (2) from the socket on the
system board.

Reverse this procedure to install the RTC battery. When installing the RTC battery, make sure the “+”
sign faces up.
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System board

@NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

For use in all countries and regions except the People's Republic of China:

Equipped with an Intel Quad Core i7-3687U 2.10-GHz processor (SC turbo up to 3.30-GHz, 714520-501
1600-MHz FSB, 4.0-MB L3 cache, 17 W) and the Windows 8 Standard operating system

Equipped with an Intel Quad Core i7-3687U 2.10-GHz processor (SC turbo up to 3.30-GHz, 714520-601
1600-MHz FSB, 4.0-MB L3 cache, 17 W) and the Windows 8 Professional operating system

Equipped with an Intel Quad Core i7-3687U 2.10-GHz processor (SC turbo up to 3.30-GHz, 714520-001
1600-MHz FSB, 4.0-MB L3 cache, 17 W) and the Windows 7 operating system

Equipped with an Intel Quad Core i7-3667U 1.80-GHz processor (SC turbo up to 2.90-GHz, 4.0- 693360-501
MB L3 cache, 17 W) and the Windows 8 Standard operating system

Equipped with an Intel Quad Core i7-3667U 1.80-GHz processor (SC turbo up to 2.90-GHz, 4.0- 693360-601
MB L3 cache, 17 W) and the Windows 8 Professional operating system

Equipped with an Intel Dual Core i7-3667U 1.80-GHz processor (SC turbo up to 2.90-GHz, 4.0-  693360-001
MB L3 cache, 17 W) and the Windows 7 operating system

Equipped with an Intel Dual Core i5-3437U 1.90-GHz processor (SC turbo up to 2.90-GHz, 714519-501
1600-MHz FSB, 3.0-MB L3 cache, 17 W) and the Windows 8 Standard operating system

Equipped with an Intel Dual Core i5-3437U 1.90-GHz processor (SC turbo up to 2.90-GHz, 714519-601
1600-MHz FSB, 3.0-MB L3 cache, 17 W) and the Windows 8 Professional operating system

Equipped with an Intel Dual Core i5-3437U 1.90-GHz processor (SC turbo up to 2.90-GHz, 714519001
1600-MHz FSB, 3.0-MB L3 cache, 17 W) and the Windows 7 operating system

Equipped with an Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to 2.70-GHz, 3.0-  693358-501
MB L3 cache, 17 W) and the Windows 8 Standard operating system

Equipped with an Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to 2.70-GHz, 3.0-  693358-601
MB L3 cache, 17 W) and the Windows 8 Professional operating system

Equipped with Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to 2.70-GHz, 3.0-MB  693358-001
L3 cache, 17 W) and the Windows 7 operating system

Equipped with an Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to 2.60-GHz, 3.0-  693357-501
MB L3 cache, 17 W) and the Windows 8 Standard operating system

Equipped with an Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to 2.60-GHz, 3.0-  693357-601
MB L3 cache, 17 W) and the Windows 8 Professional operating system

Equipped with Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to 2.60-GHz, 3.0-MB  693357-001
L3 cache, 17 W) and the Windows 7 operating system

Equipped with an Intel Dual Core i5-3217U 1.70-GHz processor (SC turbo up to 2.60-GHz, 3.0-  693356-501
MB L3 cache, 17 W) and the Windows 8 Standard operating system

Equipped with an Intel Dual Core i5-3217U 1.70-GHz processor (SC turbo up to 2.60-GHz, 3.0-  693356-601
MB L3 cache, 17 W) and the Windows 8 Professional operating system

Equipped with Intel Dual Core i3-3217U 1.80-GHz processor (3.0-MB L3 cache, 17 W) and the ~ 693356-001
Windows 7 operating system
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Description Spare part number

For use only in the People's Republic of China:

Equipped with Intel Dual Core i7-3667U 1.80-GHz processor (SC turbo up to 2.90-GHz), 4.0-MB  694511-001
L3 cache, 17 W

Equipped with Intel Dual Core i5-3427U 1.70-GHz processor (SC turbo up to 2.70-GHz), 3.0-MB  694510-001
L3 cache, 17 W

Equipped with Intel Dual Core i5-3317U 1.70-GHz processor (SC turbo up to 2.60-GHz), 3.0-MB  694509-001
L3 cache, 17 W

Equipped with Intel Dual Core i3-3217U 1.80-GHz processor, 3.0-MB L3 cache, 17 W 694508-001

Before removing the system board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 56), and then remove the following components:

a. Service cover (see Service cover on page 58)

b. Hard drive (see Hard drive on page 59)

c.  WILAN module (see WLAN module on page 62)

d. WWAN module (see WWAN module on page 64)

e. Fan (see Fan on page 68)

f. Keyboard (see Keyboard on page 69)

g. Base enclosure (see Base enclosure on page 76)

E’%NOTE: When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:

e SIM (see SIM on page 57)

®  Memory module (see Memory module on page 66)

®  RTC battery (see RTC battery on page 86)

®  Heat sink (see Heat sink on page 91)

Remove the system board:

1. Remove the two Phillips PM2.0x3.4 screws (1) that secure the system board to the top cover.
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2. Llift the rear edge of the system board (2) and swing it up and forward until it rests upside down in
front of the computer.

3. Release the ZIF connector to which the TouchPad cable is connected, and then disconnect the
TouchPad cable (1) from the system board.

4. Release the ZIF connector to which the Smart Card reader board cable is connected, and then
disconnect the Smart Card reader board cable (2) from the system board.

5. Remove the system board.

Reverse this procedure to install the system board.
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Heat sink

Description Spare part number

Heat sink (includes replacement thermal material) 693307-001

Before removing the heat sink, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 56), and then remove the following components:

a.
b.
c.

d.

h.

Service cover (see Service cover on page 58)

Hard drive (see Hard drive on page 59)

WLAN module (see WLAN module on page 62)

WWAN module (see WWAN module on page 64)

Fan (see Fan on page 68)

Keyboard (see Keyboard on page 69)

Base enclosure (see Base enclosure on page 76)

System board (see System board on page 88)

Remove the heat sink:

1. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four captive Philllips
screws (1) that secure the heat sink to the system board.
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2. Remove the heat sink (2).

[/ NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
the system board components, it may be necessary to move the heat sink from side to side to
detach it.

[ NOTE:  The thermal material must be thoroughly cleaned from the surfaces of the heat sink and
the system board components each time the heat sink is removed. Replacement thermal material is
included with the heat sink and system board spare part kits. Thermal paste is used on the
processor (1) and the heat sink section (2) that services it.

Reverse this procedure to install the heat sink.
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Smart Card reader assembly

Description Spare part number

Smart Card reader assembly (includes cable) 693312-001

Before removing the Smart Card reader assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 56), and then remove the following components:

b.

o

-
h

g.
h

Service cover (see Service cover on page 58)

Hard drive (see Hard drive on page 59)

WLAN module (see WLAN module on page 62)

WWAN module (see WWAN module on page 64)

Fan (see Fan on page 68)

Keyboard (see Keyboard on page 69)

Base enclosure (see Base enclosure on page 76)

System board (see System board on page 88)

Remove the Smart Card reader assembly:

1. Remove the two Phillips PM2.0x3.4 screws (1) that secure the Smart Card reader assembly to the
top cover.

2. Slide the Smart Card reader assembly (2) to the left to release it from the clips built into the
top cover.
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3. Remove the Smart Card reader assembly (3).

Reverse this procedure to install the Smart Card reader assembly.

Top cover

%NOTE: The top cover spare part kit includes the TouchPad. The TouchPad cable is included in the
Cable Kit, spare part number 693306-001.

Description Spare part number
For use on computer models equipped with a fingerprint reader 693317001
For use on computer models not equipped with a fingerprint reader 694507-001

%NOTE: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see the individual removal subsections.

Before removing the display assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 56), and then remove the following components:

a. Service cover (see Service cover on page 58)

b. Hard drive (see Hard drive on page 59)

c.  WIAN module (see WLAN module on page 62)
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d. WWAN module (see WWAN module on page 64)

e. Fan (see Fan on page 68)

f. Keyboard (see Keyboard on page 69)

g. Base enclosure (see Base enclosure on page 76)

h. System board (see System board on page 88)

@NOTE: When replacing the top cover, be sure to remove the following components from the
defective top cover and install them on the replacement top cover:

®  Fingerprint reader board (see Fingerprint reader board on page 61)

e  Media Card reader assembly (see Media Card reader assembly on page 84)

e  Smart Card reader assembly (see Smart Card reader assembly on page 93)

Remove the top cover:

1. Release the leftside wireless antenna cables (1) from the clips (2) and routing channel built into
the top cover.

2. Release the display panel cable (3) and rightside wireless antenna cables from the clips (4) and
routing channel built into the top cover.

3. Remove the two Phillips PM2.0x5.0 screws (5) that secure the top cover to the display assembly.
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4. Disengage the top cover (1) from the display assembly, making sure to guide the leftside wireless
antenna cables (2) through the top cover left-side opening (3) and the display panel cable (4)
and the right-side wireless antenna cables through the top cover right-side opening (5).

Reverse this procedure to install the top cover.
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Display assembly subcomponents

E"%NOTE: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see the individual removal subsections.

To access the display assembly subcomponents, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 56), and then remove the following components:

b.

="
.

g.
h

.
1.

Service cover (see Service cover on page 58)

Hard drive (see Hard drive on page 59)

Optical drive (see Hard drive on page 59)

WILAN module (see WLAN module on page 62)
WWAN module (see WWAN module on page 64)

Fan (see Fan on page 68)

Keyboard (see Keyboard on page 69)

Base enclosure (see Base enclosure on page 76)

System board (see System board on page 88)

1. [Ifitis necessary to replace the display bezel or any of the display assembly subcomponents:

Remove the display bezel screw covers (1).

The display bezel screw covers are available in the Rubber Kit, spare part number
693355-001.

Remove the two Phillips PM2.0x4.2 screws (2) that secure the display bezel and the display
clutch cover to the display assembly.
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c. Remove the display clutch cover (3).

The display clutch cover is available using spare part number 693311-001.

d. Flex the inside edges of the bottom edge (1), the left and right sides (2), and the
top edge (3) of the display bezel until the bezel disengages from the display enclosure.

e. Remove the display bezel (4).

The display bezel is available using spare part numbers 693302-001 (for use on computer
models equipped with a webcam) and 693303-001 (for use on computer models not
equipped with a webcam).
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If it is necessary to replace the display hinges, display hinge covers, and/or display hinge caps:

a. Remove the two Phillips PM2.0x4.2 screws (1) that secure the display hinge to the
display enclosure.

b. Remove the display hinge (2) from the display enclosure.
c. Remove the display hinge cap (3) from the display hinge.

d. Remove the Phillips PM2.0x4.2 screw (4) that secures the display hinge cover to the
display hinge.

e. Remove the display hinge cover (5) from the display hinge.

The display hinges, display hinge caps, and display hinge covers are included in the Display
Hinge Cover Kit, spare part number 693310-001.
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3. Ifitis necessary to replace the display panel:

a. Remove the four Phillips PM2.0x4.2 screws (1) that secure the display panel to the
display enclosure.

=]
[l s
|
[
[
[

4
4

b. Release the display panel cable (1) from the clips (2) and routing channel built into the
bottom edge of the display enclosure.

/\ CAUTION: Before turning the display panel upside down, make sure the work surface is
clear of tools, screws, and any other foreign obijects. Failure to follow this caution can result
in damage to the display panel.

c. Llift the top edge of the display panel (3) and swing it up and forward until it rests upside
down in front of the display enclosure.

d. Release the adhesive support strip (4) that secures the display panel cable to the
display panel.

e. Release the support bar (5) that secures the display panel cable to the display panel.

100  Chapter 4 Removal and replacement procedures



f. Disconnect the display panel cable (6) from the display panel.

g. Remove the display panel.
The display panel is available using spare part number 693361-001.
4. |fitis necessary to replace the display panel cable:
a. Disconnect the display panel cable (1) from the webcam/microphone module.
b. Remove the display panel cable (2).

The display panel cable is included in the Display Cable Kit, spare part number
693305-001.
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5. Ifitis necessary to replace the webcam/microphone module:

/\ CAUTION: Handle the webcam/microphone module with caution. The module has a thin

profile and is susceptible to damage when not handled carefully.

a. Detach the webcam/microphone module (1) from the display enclosure. (The webcam/
microphone module is attached to the display enclosure with double-sided tape.)

b. Detach the webcam/microphone module cable (2) from the display enclosure. (The
webcam/microphone module cable is attached to the display enclosure with double-
sided tape.)

c. Disconnect the webcam/microphone module cable (3) from the webcam/
microphone module.

d. Remove the webcam/microphone module (4).

The webcam/microphone module is available using spare part number 693318-001. The
microphone module is available using spare part number 693313-001.

6. |Ifitis necessary fo replace the WLAN antenna cables and transceivers:

a. Detach the WLAN antenna transceivers (1) from the display enclosure. (The WLAN antenna
transceivers are attached to the display enclosure with double-sided tape.)

b. Release the WLAN antenna cables from the clips (2) and routing channel built into the
display enclosure.
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c. Remove the WLAN antenna cables and transceivers (3). The WLAN antenna cables and
transceivers are included in the Antenna Kit, spare part number 693299-001.

7. Ifitis necessary to replace the WWAN antenna cables and transceivers:

a. Detach the WWAN antenna transceivers (1) from the display enclosure. (The WWAN
antenna transceivers are attached to the display enclosure with double-sided tape.)

b. Release the WWAN antenna cables from the clips (2) and routing channel built into the
display enclosure.
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c. Remove the WWAN antenna cables and transceivers (3). The WWAN antenna cables and
transceivers are included in the Antenna Kit, spare part number 693299-001.

Reverse this procedure to reassemble and install the display assembly.
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5 Computer Setup (BIOS) and
Advanced System Diagnostics

Windows 8

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of the
computer, and the amount of system and extended memory.

E’%NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

r__f'%NOTE: An external keyboard or mouse connected to a USB port can be used with Computer
Setup only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

4

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu
message is displayed at the bottom of the screen.

2. Press {10 to enter Computer Setup.
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Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e  To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press entfer, or use a pointing device to click the item.

e To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e  To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

@NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

e  To exit Computer Setup menus without saving your changes:
Click the Exit icon in the lower-left corner of the screen, and then follow the on-screen instructions.
—or—

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

e To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

—or —

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.
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Restoring factory settings in Computer Setup

[ NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press f10 to enter Computer Setup.
Use a pointing device or the arrow keys to select File > Restore Defaults.

Follow the on-screen instructions.

o S

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

E‘jNOTE: Your password settings and security settings are not changed when you restore the
factory seftings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP website.
Most BIOS updates on the HP website are packaged in compressed files called SoftPags.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.
2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

—or —

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.
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Downloading a BIOS update

/\ CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, type h, and then select Help and Support.

2. Inthe Help and Support search box, type maintain, and then follow the on-screen
instructions to identify your computer and access the BIOS update you want to download.

3. At the download areq, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.

@NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. From the Start screen, type e, and then click File Explorer.
2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Doubleclick the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

@NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

e  System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

e  Startup test—This test analyzes the main computer components that are required to start
the computer.

®  Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

®  Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

®  Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

e  Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact HP support to report the issue and purchase a
replacement battery.

e  BIOS Management—You can update or rollback the version of the BIOS on the system. Do not
shut down or remove external power during the process. You will be given a confirmation screen
before your BIOS is modified. Select BIOS update, BIOS Rollback, or Back to
main menu.

You can view system information and error logs or select languages in the Advanced System
Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press 2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

E’jNOTE: NOTE: you need to stop a diagnostics test while it is running, press esc.
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Windows 7

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of the
computer, and the amount of system and extended memory.

@NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

@NOTE: An external keyboard or mouse connected to a USB port can be used with Computer
Setup only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press {10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press entfer, or use a pointing device to click the item.

e  To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e  To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

E%NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.
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To exit Computer Setup menus, choose one of the following methods:

® To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

—or —

e To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

—Oor —

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

E’%NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press f10 to enter Computer Setup.
Use a pointing device or the arrow keys to select File > Restore Defaults.

Follow the on-screen instructions.

L S

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

E’/f’NOTE: Your password settings and security settings are not changed when you restore the
factory seftings.
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Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.
Most BIOS updates on the HP Web site are packaged in compressed files called SoftPags.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:
1. Start Computer Setup.
2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

—or —

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enfer.

@NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the
screen, and then pressing the 1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

/\ CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation,
download and install a BIOS update only when the computer is connected to reliable external power
using the AC adapter. Do not download or install a BIOS update while the computer is running on
battery power, docked in an optional docking device, or connected to an optional power source.
During the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your Web browser. For U.S. support, go to hitp://www.hp.com/go/contactHP.
For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.
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3. Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer and
access the BIOS update you want to download.

Click your specific product from the models listed.

Click the appropriate operating system.

o o &

Go to the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.

E’%NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

e  Start-up test—This test analyzes the main computer components that are required to start
the computer.

®  Run-in test—This fest repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

e  Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

®  Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

®  Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact support to report the issue and purchase a replacement battery.

e  System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.
To start Advanced System Diagnostics:

1. 1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press {2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

E’/fNOTE: If you need to stop a diagnostics test while it is running, press esc.
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SuUSE Linux (SLED)

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of the
computer, and the amount of system and extended memory.

@NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

@NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press {10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press entfer, or use a pointing device to click the item.

e  To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e  To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

E‘jNOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.
To exit Computer Setup menus, choose one of the following methods:

e  To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

—or —
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Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

—Oor —

® To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

[Bf NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press 10 to enter Computer Setup.
Use a pointing device or the arrow keys to select File > Restore Defaults.

Follow the on-screen instructions.

o S A

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

E’%’NOTE: Your password settings and security settings are not changed when you restore the factory
seftings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.
Most BIOS updates on the HP Web site are packaged in compressed files called SoftPags.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
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Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:
1. Start Computer Setup.
2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

—or —

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

B NOTE:  You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the
screen, and then pressing the 1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

/\ CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation,
download and install a BIOS update only when the computer is connected to reliable external power
using the AC adapter. Do not download or install a BIOS update while the computer is running on
battery power, docked in an optional docking device, or connected to an optional power source.
During the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your web browser. For U.S. support, go to http://www.hp.com/go/contactHP. For
worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.

3. Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer and
access the BIOS update you want to download.

Click your specific product from the models listed.
Click the appropriate operating system.

Go to the BIOS section and download the BIOS software package.

N s » s

Follow the installation instructions as provided with the downloaded BIOS software package.
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Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

e  Start-up test—This test analyzes the main computer components that are required to start the
computer.

®  Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

®  Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

®  Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

e  Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact support to report the issue and purchase a replacement battery.

e  System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.
To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press 2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

@NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications

Computer specifications

118

Metric u.s.
Dimensions
Width 29.20 cm 11.50 in
Depth 19.20 cm 7.56in
Height 2.65 cm 1.04 in
Weight (equipped with 4-cell battery, hard drive, 1 1.33 kg 2.93 lbs

memory module, and WLAN module)

Input power

Operating voltage and current

185Vdc@3.5A-65W
18.5Vdc @ 3.5 A-65W, Slim Adapter

19.5Vdc@3.33A-65W

Temperature

Operating 5°C to 35°C 41°F to 95°F
Nonoperating -20°C to 60°C -4°F to 140°F
Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)

Operating

-15mto 3,048 m -50 ft to 10,000 ft

Nonoperating

-15mto 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this

range of temperatures.
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11.6-inch SGA display specifications

Metric u.s.
Dimensions
Height 14.70 cm 579 in
Width 25.90 cm 10.20 in
Diagonal 29.50 cm 11.61in

Number of colors

Up to 16.8 million

Contrast ratio

200:1 (typical)

Brightness

200 nits (typical)

Pixel resolution

Pitch

0.197 X 0.197 mm

Format

1366 x 768

Configuration

RGB vertical stripe

Backlight LED
Character display 80 x 25
Total power consumption 20w

Viewing angle

+65° horizontal, +£50° vertical (typical)

11.6-inch SGA display specifications
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Hard drive specifications

750-GB* 500-GB* 320-GB*
Dimensions
Height 9.5 mm 9.5 mm 9.5 mm
Length 100.2 mm 100.4 mm 100.4 mm
Width 69.9 mm 69.9 mm 69.9 mm
Weight 110 g 110g 110 g
Interface type SATA SATA SATA
Transfer rate
Synchronous (maximum) 1.1 GB/sec 1.1 GB/sec 1.1 GB/sec
Security ATA security ATA security ATA security
Seek times (typical read, including setting)
Single track 2.0 ms 1.5 ms 1.5ms
Average (read/write) 12/16 ms 11/13 ms 11/13 ms
Maximum 22 ms 22 ms 22 ms
Logical blocks 1,465,149,168 976,773,168 628,142,448
Disk rotational speed 7200 rpm 7200 rpm 7200 rpm
Operating temperature 0°C to 60°C (32°F to 140°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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7 Backup and recovery

Windows 8

To protect your information, use Windows backup and restore utilities to back up individual files and
folders, back up your entire hard drive, create system repair media (select models only) by using the
installed optical drive (select models only) or an optional external optical drive, or create system restore
points. In case of system failure, you can use the backup files to restore the contents of your computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed options.

E%fNOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. From the Start screen, type h, and then select Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

E’%NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information. From the Start
screen, type h, and then select Help and Support.

Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system repair
media and your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. As you add new software and data files, you should continue to back up your system
on a regular basis o maintain a reasonably current backup. The system repair media (select models
only) are used to start up (boot) the computer and repair the operating system in case of system
instability or failure. Your initial and subsequent backups allow you to restore your data and settings if
a failure occurs.

From the Start screen, type backup, click Settings, and then select Save backup copies of your
files with File History.

You can back up your information to an optional external hard drive or a network drive.
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Note the following when backing up:
e  Store personal files in the Documents library, and back it up regularly.
e Back up templates that are stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore:

@NOTE: Be sure that the computer is connected to AC power before you start the backup process.

@NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.

1. From the Start screen, type backup, click Settings, and then select from the list of
displayed options.

2. Follow the on-screen instructions to set up your backup, create a system image (select models

only), or create system repair media (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

®  Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

e {11 recovery tools: You can use the {11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

@NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created (select models only), you must purchase Windows 8 operating system
media to reboot the computer and repair the operating system. For additional information, see the
“Using Windows 8 operating system media (purchased separately)” section.

Using the Windows recovery tools
To recover information you previously backed up:
A From the Start screen, type h, and then select Help and Support.

To recover your information using Startup Repair, follow these steps:
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/\ CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. Al files
you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. |If possible, check for the presence of the HP Recovery partition and the Windows partition.
From the Start screen, type e, and then click File Explorer.
—or—

From the Start screen, type c, and then select Computer.

%/%"NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 8 operating system DVD and the Driver
Recovery media (both purchased separately). For additional information, see the “Using Windows
8 operating system media (purchased separately)” section.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer. After
Windows has loaded, press and hold the shift key while clicking Restart.

4. Select Startup Repair.

5. Follow the on-screen instructions.

=2 NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support. From the Start screen, type h, and then select
Help and Support.

Using f11 recovery tools

/\ CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The {11 recovery tool reinstalls the operating system and HP programs and drivers that were
installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:
1. If possible, back up all personal files.

2. |If possible, check for the presence of the HP Recovery partition: From the Start screen, type c, and
then select Computer.

@NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 8 operating system media and the Driver Recovery media (both
purchased separately). For additional information, see the “Using Windows 8 operating system
media (purchased separately)” section.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.
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4. Press {11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using Windows 8 operating system media (purchased separately)

To order a Windows 8 operating system DVD, go to http://www.hp.com/support, select your country
or region, and follow the on-screen instructions. You can also order the DVD by calling support. For
contact information, see the Worldwide Telephone Numbers booklet included with the computer.

/\ CAUTION: Using a Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 8 operating system DVD:

@NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 8 operating system DVD into the optical drive
before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 8 operating system media and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Using Windows Refresh for quick and easy recovery

When your computer is not working properly and you need to regain system stability, the Windows
Refresh option allows you to start fresh and keep what is important to you.

@IMPORTANT: Refresh removes any traditional applications that were not originally installed on the
system at the factory.

@NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a
quick way to see what you might need to reinstall. See Help and Support for instructions on reinstalling
traditional applications. From the Start screen, type h, and then select Help and Support.

@NOTE: You may be prompted for your permission or password when using Refresh. See Windows
Help and Support for more information. From the Start screen, type h, and then select
Help and Support.
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To start Refresh:

1.

On the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

Click Settings.

Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

Under Refresh your PC without affecting your files, select Get started, and follow the
on-screen instructions.

Remove everything and reinstall Windows

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option removes
all personal data, apps, and settings from your computer, and reinstalls Windows.

E’jIMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the 11 key or from the Start screen.

To use the f11 key:

1.

2,
3.

Press f11 while the computer boots.

—or-

Press and hold 11 as you press the power button.
Select Troubleshoot from the boot options menu.

Select Reset your PC, and follow the on-screen instructions.

To use the Start screen:

1.

On the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

Click Settings.

Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

Under Remove everything and reinstall Windows, select Get started, and follow the
on-screen instructions.

Windows 8
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Using HP Software Setup

HP Software Setup can be used fo reinstall drivers or select software that has been corrupted or deleted
from the system.

1.

From the Start screen, type HP Software Setup, and select Apps.

2. Open HP Software Setup.

3.

Follow the on-screen directions to reinstall drivers or select software.

Windows 7

To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only) with
the installed optical drive (select models only) or an optional external optical drive, or create system
restore points. In case of system failure, you can use the backup files to restore the contents of

your computer.
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Windows Backup and Restore provides the following options:

Creating a system repair disc (select models only) by using the installed optical drive (select
models only) or an optional external optical drive

Backing up your information

Creating a system image (select models only)
Scheduling automatic backups (select models only)
Creating system restore points

Recovering individual files

Restoring the computer to a previous state

Recovering information using recovery tools

@NOTE: For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

E/?’NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. See Help and Support for more information.
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Creating recovery media with HP Recovery Disc Creator

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery
media. After you successfully set up the computer, you can create recovery media using HP Recovery
Disc Creator. This recovery media allows you to reinstall your original operating system as well as
select drivers and applications if the hard drive becomes corrupted.

HP Recovery Disc Creator can create two kinds of recovery DVDs as follows:
®*  Windows DVD—Installs the operating system without additional drivers or applications.

e Driver DVD—Installs specific drivers and applications only, in the same way that the HP Software
Setup utility installs drivers and applications.

Creating recovery media

E’%NOTE: The Windows DVD can be created only once. Thereafter, the option to create that media will
not be available.

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.
2. Select Driver DVD or Windows DVD.

3. From the drop-down menu, select the drive for burning the recovery media.

4

Click the Burn button to start the burning process.

Backing up your information

Recovery after a system failure is as good as your most recent backup. Immediately after setting up the
computer, you should create system repair discs (select models only) using the installed optical drive
(select models only) or an optional external optical drive and back up your system. As you add new
software and data files, you should continue to back up your system on a regular basis to maintain a
reasonably current backup. The system repair discs (select models only) are used to start up (boot) the
computer and repair the operating system in case of system instability or failure. Your initial and
subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:

®  Store personal files in the Documents library, and back it up regularly.

®  Back up templates that are stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

®  When backing up to discs, use any of the following types of discs (purchased separately): CDR,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend on the
type of optical drive you are using.
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@NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

e When backing up to discs, number each disc before inserting it into the external drive.

To create a backup using Backup and Restore:

@NOTE: Be sure that the computer is connected to AC power before you start the backup process.

@NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select
models only), or create a system repair disc (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

®  Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

o

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

@NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. For additional information, see the Using a
Windows 7 operating system DVD (purchased separately) section.

Using the Windows recovery tools
To recover information you previously backed up:
1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select
models only), or your files.

To recover your information using Startup Repair, follow these steps:

/\ CAUTION: Some Startup Repair options completely erase hard drive contents and reformat the hard
drive. All files you have created and any software installed on the computer are permanently removed.
When reformatting is complete, the recovery process restores the operating system, as well as the
drivers, software, and utilities from the backup used for recovery.

1. |If possible, back up all personal files.
2. |If possible, check for the presence of the Windows partition.

To check for the Windows partition, select Start > Computer.
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3. If the Windows partition is listed, restart the computer, and then press {8 before the Windows
operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

E"jNOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11 recovery tools

/\ CAUTION: Using 11 recovery tools completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently removed.
The f11 recovery tool reinstalls the operating system and HP programs and drivers that were installed at
the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:
1. If possible, back up all personal files.

2. |f possible, check for the presence of the HP Recovery partition: click Start, right-click Computer,
click Manage, and then click Disk Management.

@NOTE: If the HP Recovery partition has been deleted, the {11 restore option will not function.
You must recover your operating system and programs using the Windows 7 operating system
DVD and the Driver Recovery disc (both purchased separately) if the Windows partition and the
HP Recovery partition are not listed. For additional information, see the Using a Windows 7
operating system DVD (purchased separately) section.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press 11 while the “Press <F11>" for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows 7 operating system DVD (purchased separately)

To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to

http:// www.hp.com/go/contactHP. For worldwide support, go to http://welcome.hp.com/country/
us/en/ wwcontact us.html. You can also order the DVD by calling support. For contact information,
see the Worldwide Telephone Numbers booklet included with the computer.

/\ CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

@NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system load:s.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD, and then insert the Driver Recovery disc.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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SuUSE Linux (SLED)

Recovery after a system failure is as good as your most recent backup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup.

Your computer includes tools provided by HP to help you safeguard your information and retrieve it if

ever needed.

Creating backups

1. Create restore media immediately after you set up the computer. For more information, see the
“Performing a system recovery” section.

2. Asyou add files, routinely create a backup of your system and personal information.

Backing up your information

You should back up your computer files on a regular schedule to maintain a current backup. You can
manually back up your information to an optional external drive, a network drive, or discs. Back up
your system at the following times:

e  Atregularly scheduled times

e  Before the computer is repaired or restored

e  Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:

1. Select Computer > More Applications > Tools > Backup Manager Settings, and click
Backup my home directory.

2. Click Storage Destination Location, and then select a location to back up your information.

3. Click Schedule, and then select a time schedule to perform backups at a regularly scheduled
time.

To immediately back up your information, click the Backup Now check box.

@NOTE: Before you back up your information, be sure you have designated a location to save
the backup files.

4. Click Save and Backup to start the backup and to save the backup settings.

To restore backup files:

1. Select Computer > More Applications > Tools > Backup Manager Restore.
2. Click Backup Source, and then select the location of the backup files.

3. Click Restore Destination, and then select the destination to restore the files.
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4. To restore all files from the selected location, click Restore all files. To restore select files only,
click Restore selected files, click Select Files and then select the files to be restored.

5. Under Restore Point, click the time and date of the backup.

[Bf NOTE: If multiple backups have been performed, click Use the latest version fo restore the
|latest version.

6. Click Restore to start restoring the files, or click Cancel to cancel the operation.

Performing a system recovery

Recovery allows you to repair or restore the computer to its original factory state. You can create an HP
Factory Image Restore DVD, using an installed or an external DVD+RW optical drive.

/\ CAUTION: CAUTION: Using Recovery completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently removed.
The recovery tool reinstalls the original operating system and HP programs and drivers that were
installed at the factory. Software, drivers, and updates not installed by HP must be manually reinstalled.
Personal files must be restored from a backup.

To restore the computer using the HP Factory Image Restore DVD, you must first create the recovery
disc. To create the recovery disc:

@NOTE: HP recommends that you create the HP Factory Image Restore DVD in the event of a system
failure.

1. Select Computer > More Applications.

2. In the left pane, click Tools, and then click Create HP Factory Image Restore DVD in the
right pane.

3. Follow the on-screen instructions to create an image file to burn a recovery disc.

To restore the computer from the recovery disc, follow these steps:

1. |If possible, back up all personal files.

Insert the HP Factory Image Restore DVD into the optical drive and restart the computer.

As the computer is restarting, press {9 to open the Computer Setup boot option menu.

Ll S

Press the down arrow to select Restore SLED HP-BNB preload image from the Linux boot
menu, and then press enter.

5. Using the arrow keys, select Yes when prompted: Do you want to start the System-
Restore?

6. Follow the on-screen instructions.
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USB Recovery option (select models only)

The USB Recovery Disk On Key (flash drive) option allows you to create a backup image of the SLED
operating system installed on select HP Business Notebooks. This Disk On Key may be used to restore
the system to the original factory state when the F11 recovery option is not available. This process
should be done on first obtaining the computer.

/\ CAUTION: The USB recovery option does not preserve data present on the computer’s hard drive or
on the Disk On Key used for the recovery process. Back up any data on the Disk on Key or the
notebook that will be recovered before starting.

@NOTE: HP recommends that you create the USB Recovery Disk in the event of a system failure. The
Disk On Key used for this process should be 4 GB or larger.

Creating a USB Recovery Disk On Key

1. Connect the USB Disk On Key to a USB port on the computer.

Select Computer > More applications > Tools > Create Recovery USB.
Enter the root password when prompted.

Select USB Disk On Key from the list.

Click OK.

A O T o

A question dialog will remind you that the data on the USB key will be destroyed. To continue,
click OK. Otherwise, click Cancel and back up the contents of the Disk On Key on another
computer.

7. The backup process will display a status dialog box while the backup is in progress.

@NOTE: A file browser window with the Disk On Key Contents displayed will pop up when the
key is mounted. You may close the file browser window if desired. Once the USB Recovery Key
has been created, the status dialog will close. The USB Recovery Key is ready for use.

Recovering from a USB Recovery Disk On Key

/\ CAUTION: Before starting the Recovery process, make sure any data on the system to be recovered
has been backed up. The recovery process destroys all data on the system to be recovered.

1. Turn off the computer.
Connect the USB Disk On Key to a USB port on the computer.
Turn on the computer while holding down the 9 key.

Once the system has booted, the Boot Options menu should appear.

b R

Using the arrow keys, select USB Disk On Key and press enfer.

@NOTE: The description may vary from one USB key to another. Any entry other than Optical
Disk Drive, Notebook Hard Drive or Notebook Ethernet should be the USB Recovery Disk On Key.

6. Once the USB Recovery Disk On Key has been selected, press enter. The USB Recovery Disk On
Key will boot.
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7. Once the USB Recovery Disk On Key has booted, a dialog box will prompt, “Do you want to start
the System-Restore?” If data on the computer has not been backed up, use the tab key and select
No. The system will reboot. Back up the system data and repeat the previous steps. If no data
should be saved from the computer, use the tab key to select Yes. Press enter to begin the
recovery process.

8. Atter the files are copied to the system, follow the on-screen instructions.

Remove everything and reinstall SLED

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer fo its original state. This option removes
all personal data, applications, and settings from your computer, and reinstalls the Linux operating
system.

@IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the {11 key.

To use the 11 key:

Press {11 while the computer boots.

—or-

Press and hold {11 as you press the power button.

The following options are available:

e Cancel/Reboot—Reboots the system. No recovery or restore activity is performed.

®  Recover/Repair System—This option repairs a system that is not working properly and preserves
user data.

®  Restore Factory System—This option restores the system back to the original factory state. User
data is not preserved.

Select an option and follow the on-screen instructions.
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8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries

The following requirements are applicable to all countries and regions:
e The length of the power cord set must be at least 1.0 m (3.3 ft) and no more than 2.0 m (6.5 ).

e All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

®  The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

e The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
Italy IMQ 1
Japan METI 3
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China CocC 5
South Korea EK 4
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States uL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm? conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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9 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose

of the battery in general household waste. Follow the local laws and regulations in your area for
battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and

rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.
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